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Tampereen Veden Viemérilaitoksen laboratoriolle hankittiin kesalla 2013 uusi Metrohm
883 Basic IC Plus ionikromatografi vanhan ionikromatografin tilalle. Uuden laitteen
kayttoonotto ja osittainen validointi tehtiin opinndytetyond. Opinnédytetydn tavoitteena
oli varmistaa laitteen toimivuus ja kehittdd menetelm&én liittyvid toimintatapoja.
Tarkoituksena oli tehdd uudelle ionikromatografille menetelméohje ja kouluttaa
henkil6kuntaa laitteen k&ytdssa.

Laitteen toimintaa seurattiin sertifioiduilla vertailumateriaaleilla ja analyysien
selektiivisyyttd ja toistettavuutta tutkittiin saantokokeilla. Uuden ionikromatografin
antamia tuloksia verrattiin useaan vaihtoehtoiseen menetelmén. Anionianalyysien
tulokset olivat oikeanlaisia, kun taas kationianalyyseissa havaittiin poikkeamia.

Laitteen kayttoonoton yhteydessa esiintyi odotetusta poikkeavia tuloksia. Tuloksien
syyt pyrittiin selvittdméén ja korjaamaan kéayttéonoton aikana. Laitteen injektioneula oli
tukkeutunut kéyton aikana ja neula vaihdettiin vasta opinndytetydn tekemisen
loppuvaiheessa. Tésté johtuen validointia voidaan pitd4 vain suuntaa antavana, koska
injektioneulan vaikutuksista tuloksiin ei ole varmuutta. Vanhalla ionikromatografilla oli
analysoitu fluoridia, kloridia, nitraattia, sulfaattia ja ammoniumia. Uusi laite saatiin
toimintakuntoiseksi kéyttoonoton aikana kaikkien niiden ionien kohdalla, joita oli
analysoitu vanhalla ionikromatografilla. Lisdksi kaliumin ja natriumin analyysitulokset
olivat lupaavia. Kalsiumin ja magnesiumin tuloksissa oli epéselvyyksid ja niiden
tuloksia on syyté seurata jatkossa.
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ABSTRACT
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The laboratory of Tampere Water at the Rusko water purification plant bought a new
Metrohm 883 Basic IC Plus ion chromatograph in the summer of 2013. The new ma-
chine replaced an older ion chromatograph. This bachelor’s thesis was written about the
validation and commissioning of the new chromatograph. The objective of the thesis
was to ensure that the machine was functioning properly. The purpose of the thesis was
to write an analysis method for the new machine, and to train Tampere Water personnel
in the use of the machine.

Several different methods were used in the validation of the ion chromatograph. The
results of anion analysis tests were promising, but cation analysis results showed some
discrepancies. Several problems were found on the macine. The issues were fixed as
they were found, but a particular issue with the injection needle was only found after the
end of the time allotted for the validation. For this reason the validation was not fully
completed. The laboratory personnel will further examine the results given by the
chromatograph in the future.

Keywords: lon chromatography, IC, Tampere Water, Validation
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1 JOHDANTO

Tampereen Veden Viemérilaitoksen laboratorio hankki uuden Metrohm 883 Basic IC
plus ionikromatografin vuonna 2013. Uusi laite korvasi vanhan ionikromatografin, joka
oli ollut kaytossa jo yli 10 vuotta. Laitteen kayttoonotto ja osittainen validointi tehtiin
opinnaytetyona kesélld 2013. Opinnéytetyon tyopaikkaohjaajana toimi Marja Pitkénen.
Viemarilaitoksen laboratorio ei ole akkreditoitu, vaan laite validoitiin laboratorion

sisdista laadunvarmistusta varten.

Tyon tavoitteena oli varmistaa uuden laitteen toimivuus ja kehittdd menetelmaén
liittyvia  toimintatapoja.  Opinnédytetyon tarkoituksena oli  tehdd uudelle
ionikromatografille menetelmdohje ja kouluttaa henkilokuntaa laitteen kéytossa.
Henkil6kunnan koulutus jarjestettiin tyonteon ohessa.

lonikromatografilla  tutkitaan seka  Viemadrilaitoksen laboratorion etta
Talousvesilaboratorion naytteitd. Jatevedenpuhdistamojen prosessindytteista tutkitaan
paivittdin - ammonium-, nitraatti- ja nitriittipitoisuuksia  prosessin  toiminnan
seuraamiseksi ja varmistamiseksi. Talousvesistd ja pohjavesistd seurataan fluoridia,
kloridia, nitraattia, sulfaattia, natriumia, kalsiumia, kaliumia ja magnesiumia 1-2
kuukauden vélein. Puhtaiden vesien kationianalyysit olivat aiemmin teetetty
alihankkijalla Kokemdaenjoen vesiston vesiensuojeluyhdistyksella (KVVY). Tydssa
selvitettiin myds aiemmin alihankkijalla teetettyjen analyysien tekoa Viemarilaitoksen

laboratorion sisalla.



2 TAMPEREEN VESI

Tampereen Vesi on vuodesta 1898 saakka toiminut Tampereen kaupungin
vesihuoltolaitos. Se on nykyéaan liikelaitos ja tuottaa Tampereen alueen kunnille vetta ja
huolehtii viemardinnistd sek& jatevesien puhdistamisesta. Sen ympéristojarjestelmas
ohjaavat sek& viranomaisten myontamét luvat, ettd sosiaali- ja terveysministerion
maardédmat laatuvaatimukset. Ympéristojarjestelma on sertifioitu vuonna 2002 1SO
14001 standardin mukaisesti ja sen rinnalle rakennettiin ISO 9001 standardin mukainen
laatujérjestelmé. (Tampereen Vesi 2013b.) Pintavettd puhdistetaan Roineen ja
Nésijarven vedestda Ruskon, Kdmmenniemen ja Polson vedenottamoilla. Tampereen
pohjavesiottamot sijaitsevat Messukylassa, Hyhkyssa, Mustalammella, Julkujarvella ja
Pinsiossa. Raakavesien ja talousvesien laatua seurataan Ruskon

vedenpuhdistuslaitoksen laboratoriossa. (Tampereen Vesi 2013b.)

Jatevetta puhdistetaan Tampereella neljalla puhdistamolla, jotka ovat Viinikanlahden,
Raholan, Kammenniemen ja Polson jatevedenpuhdistamot. Jatevesistd poistetaan
mekaanisilla, kemiallisilla ja biologisilla menetelmilld orgaanista ainetta, typpeé ja
fosforia. Viemaérilaitoksen laboratorio tutkii puhdistamoiden prosessindytteiden lisaksi

jarvien, ojien, hulevesien ja teollisuuden jatevesia. (Tampereen Vesi 2013a.)

Kuvassa 1 on Viinikanlahden puhdistamon prosessikaavio, jossa on kuvattu prosessin
eri vaiheita. Jatevesi viipyy puhdistamolla noin vuorokauden. (Tampereen Vesi 2013a.)
Jatevedesta keratty liete tiivistetddn, méadatetddn ja kuivataan linkouksella.
Madatyksessa syntyy biokaasua, jota kéytetddn laitoksen energiantuotantoon. Liete
keratadn hyotykayttoon ja sitd kaytetddn esimerkiksi viherrakentamiseen ja
maanparannukseen.  Maanparannusaineeksi  kelpaavalla  aineella on tiukat
laatuvaatimukset ja Tampereen Veden puhdistamot tuottavat vaatimukset tayttavaa
lietettd. (Tampereen Vesi 2013b.)



Kalkki
Ferrisulfaatti

Vilppdys
/

Hiekan-  Hieno-
Pumppaus erotus vilppdys

Sakeutus

Vilisdilio

Viinikanlahden jatevedenpuhdistamon puhdistusprosessi

Kompressorit X
Polymeeri

LJ Pyhdjdrveen

Kuivaus
Hyatykdyttoon

Kaasugeneraattori

KUVA 1. Viinikanlahden jatevedenpuhdistamon puhdistusprosessi (Tampereen Vesi

2013)



3 IONIKROMATOGRAFIAN TEORIAA

3.1 Periaate

lonikromatografiaan kuuluvat kaikki ioneja erottavat kromatografiset menetelmét.
lonikromatografialla voidaan erottaa ja analysoida anioneja tai kationeja
monimutkaisista seoksista. Menetelmia kéaytetdén yleensa pienien epdaorgaanisten ionien
tutkimiseen, mutta viime aikoina ionikromatografiaa on sovellettu myds suurempien
orgaanisten ionien analysointiin. (Fritz & Gjerde 2009, 1.) lonikromatografeilla
tutkitaan yleisimmin nesteitd, mutta myos kaasuja ja kiinteitd partikkeleja voidaan

analysoida esikasittelyn avulla (Ullah & Takeuchi & Dasqupta 2006).

Modernissa ionikromatografiassa tunnetaan kolme peruserotusmekanismia, jotka ovat
ioninvaihtokromatografia ~ (HPIC), ioniekskluusiokromatografia  (HPICE) ja
ioniparikromatografia (MPIC) (Weiss 2004, 3-4). loninvaihtokromatografiassa
kolonnissa on kiinni kovalenttisilla sidoksilla ioneja ja ioneihin kytketynyt vastaioneja
séhkostaattisilla sidoksilla. Kun eluentti kulkee materiaalin ohi, eluentissa olevat ionit

voivat korvata sahkostaattisilla sidoksilla kiinnittyneet ionit. (Faust 1997, 118.)

lonikromatografialla on monia etuja verrattuna perinteisiin anionimittausmenetelmiin,
joita ovat esimerkiksi titrimetria, fotometria ja gravimetria. lonikromatografia on
nopeampi, herkempi ja selektiivisempi menetelmd. Lisaksi ionikromatografi pystyy
mittaamaan useita eri ioneja yhtaaikaisesti ja ndyte saadaan tarvittaessa jatkokasittelyyn.
(Weiss 2004, 7.) Verrattaessa kolorimetristd ja ionikromatografista bromidinmittaus-
menetelmdd havaittiin  kolorimetrisen menetelman mittaavan bromidin lisaksi
bromaattia. lonikromatografisella menetelmalla bromaatista ei aiheutunut hairiota.
(Neal & Neal & Wickham & Harman 2007, 6.)

lonikromatografiaa kéytetdan erityisesti ympdristdanalytiikkaan, joissa se on ldhes
taysin syrjayttanyt Kklassiset ionien tutkimusmenetelmat. Sitd pidetddn vesien ja
jatevesien tutkimuksen referenssimenetelmana. (Michalski 2010, 1.) lonikromatografiaa

on sovellettu my6ds metsépaloista l&htoisin olevien aerosolien nitraatti-, sulfaatti- ja
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ammoniumpitoisuuksien tutkimiseen (Niemi & ym 2005, 3). Energiantuotannossa
veden puhtaus on erittdin tarkedd ja ionikromatografia sopii hyvin voimalaitosten
hoyryn epépuhtauksien tutkimiseen (Cickaric 2005, 1-9).

3.2 lonikromatografin rakenne

Kuvassa 2 on kaavio ionikromatografin perusrakenteesta. Eluentti pumpataan
eluenttisailiosta kuvan kohdasta 1 ndytteen injektioyksikon tai injektioloopin kautta
kolonniin, joka on kuvassa kohdassa 2. Kolonnin jalkeen eluentti kulkee supperssorin
kautta detektoriin  kuvan kohdassa 3. Suppressori ei ole Vvéalttdmaton
ionikromatografiassa. Detektori lahettdd mittaustietoa tietokoneelle, jossa se
analysoidaan kohdassa 4. Pumpussa voi olla virtauksensaatelija, joka varmistaa
virtauksen tasaisuuden. Injektioyksikon tehtdvana on varmistaa, ettd naytetta kulkeutuu
kolonniin tarkka maara. (Fritz & Gjerde 2009, 21.)

4, Data Anal-.rsis

i 8

1. Eluent
Iejsction DE"“W
Separator
[
2. Separation

Figure 1-1. lon Analysis Process

Kuva 2. lonikromatografin rakenne (Yigiang Z. 2013)

lonikromatografiassa kéaytetddn monia erilaisia detektoreja. Selektiiviset detektorit
mittaavat vain tietyn tyyppisia ioneja, kun taas yleisdetektorit mittaavat kaikkia ioneja.

Selektiivisia detektoreja ovat esimerkiksi UV-VIS-spektrometri, massaspektrometri ja
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séhkokemialliset detektorit. Niilld paastddn yleensd parempaan mittaustarkkuuteen,
koska taustasignaali on pienempi kuin yleisdetektoreilla. Selektiiviselld detektorilla
voidaan mitata kaikenlaisia ioneja, jos ndyte kasitelladn kolonnin ja detektorin vélill&.
(Fritze & Gjerde 2009, 70.)

UV-VIS detektorit mittaavat sdhkOmagneettista sateilyd. Ne ovat hyodyllisid
havaitsemaan sellaisia ioneja, joilla on korkea absorbanssi jossain tietyssé
aallonpituudessa. Massaspektrometri on erittdin herkkd detektori ja mahdollistaa
analysoitavien ionien tunnistamisen. Se vaatii tyhjion ja ionikromatografin eluentista
perdisin oleva kaasu on poistettava tyhjion sailyttamiseksi. (Fritze & Gjerde 2009, 34.)
Yleisimmin ionikromatografiassa kaytetdan sahkonjohtavuuteen perustuvia detektoreja.
Sahkonjohtavuus riippuu analyytin ionien méaérasta ja laadusta. Pienilla helposti
liikkuvilla ioneilla on suurempi sahkonjohtokyky kuin suurilla ioneilla. (Fritze & Gjerde
2009, 71.) Sahkonjohtavuus muuttuu noin 2% yhta celsiusastetta kohden, jonka vuoksi
lampdtilan hallinta on tarked& detektorin toiminnan kannalta. L&mpétilaa voidaan
kontrolloida tai detektori voi ottaa sen huomioon mittauksessa. Eluentin lampdtilaa

voidaan muuttaa kolonniuunin avulla. (Fritze & Gjerde 2009, 33.)

Suppressorin tehtdvdna on véhentdd eluentin korkeaa taustajohtokykyd ja muuntaa
ioneja johtokykyisempaan muotoon. Se pienentdd eluentin taustajohtavuutta
kemiallisesti. (Weiss 2004, 6, 103.) Suppressorin kayttd ei ole valttaméatonta
ionikromatografiassa, koska taustan sdhkdjohtavuus voidaan pitdd riittdvan pienend
my0s matalan vaihtokyvyn ioninvaihtokolonnilla tai kayttamaélla laimeita eluentteja.
Néyteionit voidaan havaita suoraan, jos eluentti-ionien sdhkonjohtavuus poikkeaa
huomattavasti tutkittavista ioneista. (Fritz & Gjerde 2010, 8.)
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4 LAITTEEN RAKENNE JA TOIMINTA

Tampereen Veden Viemarilaitoksen laboratoriossa otettiin kayttoon kaksi kappaletta
Metrohmin 883 Basic IC plus ionikromatografeja kesédlla 2013. Toinen laite on
asennettu kationien analysointiin ja toinen anionien analysointiin. Molemmat laitteet
pystyvat tarvittaessa analysoimaan sek& anioneja ettd kationeja asennusta
muokkaamalla. Kationilaitteessa ei ole kéytdssa suppressoria, mutta se [0ytyy

tarvittaessa varaosista.

lonikromatografit on kytketty 919 IC Autosampler Plus néytteensyottajaan. Kuvassa 3
on esitetty autosamplerin perusosat. Kuvan kohdassa 1 on suojakilpi, 2 on naytekiekko,
3 on peristalttinen pumppu, 4 on hissi, jossa on adapteri neulalle ja 5 on suojalevy.
Naytteet suodatetaan ruiskusuodattimella korkillisiin muoviputkiin, jotka laitetaan
naytteensyottdjan kiekkoon. Hissiin kiinnitettdva injektioneula l&péisee korkin ja nayte
pumpataan peristalttisen pumpun avulla neulan, kapillaarien ja letkujen lapi
suodatinkennoon. Kapillaarit on valmistettu PEEK-materiaalista eli
polyeetterieetteriketonista. Peristalttisen pumpun muoviset letkut litistyvat kaytossa,

joten ne on vaihdettava séannéllisin véliajoin.

KUVA 3. Autosamplerin rakenne. (Metrohm 2013)
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Néyte pumpataan peristalttiselta pumpulta suodatinkennoon. Suodatinkennon rakenne
on kuvassa 4. Suodatinkenno on jaettu kahteen kammioon, jotka ovat kuvassa
numeroilla 1 ja 2. Kammioiden valissd on suodatinpaperi, joka on kuvassa numerolla 4.
Kuvan numero 3 on sinetdintirengas. Néyte virtaa kennon alemmassa kammiossa.
Ylempadn kammioon generoidaan tyhjio, jolloin ndyte suodattuu suodatinpaperin lapi
ylempéén kammioon. Osa ndytteestd ja suodatinpaperin l&pédisemattomat hiukkaset

ohjataan jateastiaan.

Components of the ultrafiltration cell

KUVA 4. Suodatinkennon rakenne (Metrohm 2011)

Suodatuksen jalkeen nadyte pumpataan peristalttisella pumpulla usean inline-
suodattimen kautta anionilaitteen injektiosilmukkaan, jossa se tayttda anioniloopin.
Loopin ollessa inject-asennossa eluentti kulkee elunttipullosta loopin kautta kolonniin.
Fill-asennossa néayte kulkee autosamplerilta loopin kautta kationilaitteelle. Nayte tayttaa
anioniloopin sen ollessa inject-asennossa ja jatkaa matkaa Kkationilaitteelle.
Anioniloopin tilavuus on 20ul. Kationilaitteella nayte kulkee kationiloopin kautta
jateastiaan. Kationiloopin tilavuus on 100pul. Anionilaitteessa on ké&ytdssa suppressori,
joka poistaa eluentista kationeja ja korvaa ne H* ioneilla. Suppressori pienentaa eluentin
sdhkonjohtokykya. Se kayttaa liuoksina ionivaihdettua laboratoriovetta (MilliQ) ja 0,1M
rikkihappoa.

Kuvassa 5 on ionikromatografin rakenne. Detektori on kohdassa 1. Kohdassa 3 on
supressorimoduuli  ja kohdassa 4 on korkeapainepumppu. Kohdassa 5 on

kolonninpidike, jossa on &lykas mikrosirujarjestelm&. Laite tunnistaa kolonnin tiedot
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automaattisesti sirusta ja l&hettdd ne laitetta ohjaavalle tietokoneelle. Peristalttinen

pumppu on kohdassa 6 ja injektiosilmukka kohdassa 7.

KUVA 5. lonikromatografin rakenne (Metrohm 2009)

Laitteen anionikolonni on MetroSep A Supp 5 150/4.0 ja esikolonnina on Metrosep A
Supp 4/5 Guard. Kationikolonnina kéytéssa on MetroSep C4-150/4.0 ja esikolonnina
Metrosep C-4 Guard. Esikolonnien vaihtoaika on noin puoli vuotta. Detektorina
kaytetdan sahkonjohtokykya mittaavaa IC detectoria. Eluenttisdilidissa on kaytdssa
kalsiumkloridipohjaiset molekyyliseulat, jotka vahentdvat ilman epdpuhtauksien ja
kosteuden péasya eluenttiin. Eluentti kulkee kolonniin inline-suodattimien kautta.

Kuvassa 6 on ionikromatografi asennettuna Ruskon laboratorioon.



15

KUVA 6. Metrohm 883 Basic IC Plus Ruskon laboratoriossa (Kuva: Pertti Séarela 2013)

4.1 Liuokset

Anionipuolella eluenttina kaytetaan liuosta, joka sisaltdad 3,2 mM Na,CO3; + 1,0 mM
NaHCOs. Kationipuolella eluenttina kaytetéén liuosta, joka sisaltdd 1,7 mM HNOg3 + 0,7
mM dipikoliinihappo. Eluentit laimennetaan korkeamman pitoisuuden kaupallisista
liuoksista, jotka on esitetty liitteessa 1. Valmistuksessa kaytetadn MilliQ-vettd, josta
poistetaan kaasut vakuumisuodatuksella. Anionilaitteen suppressori kéayttdd 0,1M
rikkihappoa (H,SQy,) ja ultrapuhdasta Milli-Q vetta.

4.2 Kaytts

Néytteet suodatetaan 0,45um ruiskusuodattimen Idpi néyteputkiin, jotka suljetaan
muovikorkeilla. Erittdin likaiset laimentamattomat jatevesindytteet suodatetaan
kahdesti. Ajon alussa laitteella ajetaan pohjaviivaa véahintdan puoli tuntia, jotta eluentin
pohjatason  johtokyky tasaantuisi. Laite sammuttaa eluentin  pumppauksen
automaattisesti nayteohjelman paatyttyd. lonikromatografin ja autosamplerin toimintaa

ohjataan laitteeseen kytketylla tietokoneella, jossa on Magic Net ohjelmisto.
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4.3 Menetelméaohje

Laitteen kayttoonoton yhteydessd Kirjoitettiin - menetelmdohje  vesindytteiden
liuenneiden anionien ja kationien maaritykseen ionikromatografilla. Menetelmaohje on
opinndytetyon liittessd 2. Se laadittiin vanhan ionikromatografin menetelmaohjeen
pohjalta. Laitteessa olevaa MagCl Net ohjelmistoa ei ollut aikaisemmin kaytetty
laboratoriossa ja ohjeeseen sisallettiin tarkat toimintaohjeet ohjelmiston kéaytossa.
Ohjeeseen kirjattiin myos laitteen huolto-ohjelma ja lyhyet ohjeet huoltotoimenpiteiden

suorittamiseen.
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5 VALIDOINNIN TEORIAA

Menetelmdn  validoinnissa  osoitetaan, ettd  menetelmd  sopii  aiottuun
kayttotarkoitukseen. Validoinnin tulee arvioida sekd menetelmén soveltuvuutta etta
tulosten luotettavuutta. (Ehder 2005, 25.) Validointi jaetaan yleensa eri menetelmén

osa-alueita tutkiviin komponentteihin.

Tarkkuus on mitattujen tulosten ja todellisen arvon vélinen erotus. Tarkkuutta voidaan
madarittad vertaamalla tuloksia tunnettuun sertifioituun vertailumateriaaliin, jonka tarkan
pitoisuuden on maarittanyt jokin taho. (Ehder 2005, 37.)

Toistettavuus  kuvaa tulosten muuttumista samoissa olosuhteissa tapahtuvissa
mittauksissa. Toistettavuutta voidaan tutkia mittaamalla ndyte useita kertoja samoissa
olosuhteissa useissa erillisissd sarjoissa. Jos sarjojen hajonta poikkeaa toisistaan
enemman kuin sarjojen sisdinen hajonta, on menetelméassa todellista hajontaa. (Ehder
2005, 37.) Toistettavuuden mittaaminen edellyttdd samaa mittausmenettelyd, samoja
kayttdjia, samaa mittausjarjestelméd, samoja kéyttoolosuhteita, samaa mittauspaikkaa ja
samaa kohdetta (SFS 2010, 33).

Selektiivisyys kuvaa menetelman kykyé erottaa analysoitava aine seoksesta siten, etta
muut seoksessa olevat aineet eivat héiritse analyysia. Taysin selektiivistd menetelméé
kutsutaan spesifiseksi, mutta kaytdnndssa useimmat menetelmét eivat ole taysin
selektiivisid. Selektiivisyyttd voidaan tutkia madrittamalld menetelman saanto

lisdyskokeilla tai vertaamalla toiseen tunnettuun menetelméaan. (Ehder 2005, 27.)

Saanto on menetelman kyky havaita analyytin kokonaisméaaré. Saanto voidaan maarittaa
vertaamalla menetelman tulosta tunnetun menetelmén tuloksiin, tai sertifioidulla

vertailumateriaaleilla suoritetuilla lisdyskokeilla. (Ehder 2005, 33.)

Menetelmén poikkeama kuvaa systemaattista virhettd, eli mittaustuloksen ja todellisen
arvon erotusta. Poikkeama voi koostua useista eri virheistd, joista osa voi liittya

laboratorion omiin virheisiin ja osa itse menetelméén. (Ehder 2005, 30).
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Héiriokestavyys kuvaa tulosten muuttumista analyysin eri vaiheissa tapahtuvien
toimintatapojen ja testausolosuhteiden muutosten vuoksi. Hairidita voivat aiheuttaa
esimerkiksi analyysin suorittaja, reagenssit, lampétila, pH ja muut ymparistolliset
tekijat. Hairiokestavyyttd voidaan tutkia muuttamalla joitakin  menetelmén
yksityiskohtia. (Ehder 2005, 34.)

Toteamisraja on sellainen aineen pitoisuus, jolla voidaan todeta aineen olemassaolo
naytteessd, mutta ei méaarittdd sen tarkkaa maarad. Maéaritysraja on pienin aineen
pitoisuus, joka voidaan maéarittaad tietylld epdavarmuudella. (Ehder 2005, 29.)
Toteamisraja lasketaan nollandytteen keskihajonnasta kaavalla (1). Méadritysraja
lasketaan kaavalla (2).

LOD=3*STD Q)
LOQ =10*STD )
jossa STD on ndytteen keskihajonta

LOD on toteamisraja

LOQ on mééritysraja

Sertifioidujen vertailumateriaalien kaytto on tarke&a validoinnissa, koska niiden puhtaus
ja analyytin pitoisuus on varmistettu jaljitettavasti. Vertailumateriaalin tulee olla
homogeeninen, vakaa ja tunnettu. Vertailumateriaalit voidaan jakaa primaarisiin,
sekundaarisiin ja sisdisiin vertailumateriaaleihin. Primaarimateriaalit ovat erittéin
puhtaita ja stabiileja kaasuja tai kiinteitd aineita. Sekundaarimateriaalit valmistetaan
primaarimateriaaleista. Laboratorion sisdisesti valmistettuja vertailumateriaaleja ei

voida pitaa jaljitettavina primaari- eika sekundaarimateriaalina. (Ehder 2005, 39-40.)

Menetelmdn tai laitteen patevyyttd voidaan tutkia useiden eri laboratorioiden vélisissa
vertailumittauksissa tai patevyyskokeissa. Useat saman alan laboratoriot tutkivat samoja
néytteitd ja laboratorioiden tuloksia verrataan toisiinsa ja patevyyskokeiden suorittajan

ilmoittamiin teoreettisiin referenssipitoisuuksiin. (Ehder 2005, 45.)
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6 LAITTEEN KAYTTOONOTTO JA VALIDOINTI

6.1 Kayttoonotto

lonikromatografin asentamisen jalkeen pyrittiin varmistamaan laitteen toimivuus
kayttoonoton aikana. Kayttéonoton yhteydessd ilmeni erilaisia laitteen kéaytt6a
haittaavia seikkoja. Laitteen toimivuudesta validointiajojen aikana ei ole varmuutta,
koska osa vioista ldydettiin ja korjattiin vasta opinndytety6hon varatun ajan jalkeen.
Poikkeavien tuloksien aiheuttajat pyrittiin selvittdmé&an ja korjaamaan heti ilmenemisen
jalkeen. llmenneet seikat eivat valttdméattd ole vaikuttaneet validointiajojen tuloksiin,
mutta tayttd varmuutta niiden vaikutuksesta ei voida saada ilman analyysien uusimista.

Tuloksia voidaan kuitenkin pitdd suuntaa antavina.

6.1.1 Injektioneula

Laitetta ké&yttdessd havaittiin, ettd injektioneulalta peristalttiselle pumpulle kulki
ajoittain paljon ilmaa. Ilmanotto suureni ajan kanssa. Peristalttinen pumppu hajoitti
ilmakuplat, mutta virtausnopeus pumpulta laitteelle pieneni ongelman vuoksi. Havaittiin
mya0s, ettd nayteputkista oli poistunut naytettd paljon tavallista vahemman. IImanottoa
pyrittiin korjaamaan alustavasti injektionopeutta ja injektion pumppausaikaa lisaédmalla.
Kationianalyysien kontrollien ja naytteiden tulokset pienenivat pumpun ottaessa ilmaa.
On mahdollista, ettd ilmanoton vuoksi kationilaitteen injektiolooppi ei ole tayttynyt
taydellisesti, jolloin kolonniin on kulkeutunut tavallista pienempi maéara naytetta.
Anionilaitteelle on autosamplerilta lyhyempi matka eikd anioneissa yleensa ollut
poikkeavia tuloksia.

Ongelma korjautui kun nédytteensyottajan injektioneula vaihdettiin toiseen. Kun neulaa
tutkittiin laitteen valmistajalla, havaittiin sen olevan tdynnd pienid muovinpalasia.
Alkuperdisessd neulassa néytereikd oli neulan kéarjessa ja ndytteet autosamplerissa
korkillisissa muoviputkissa. llmeisesti neulaan oli mennyt muovia korkkien
puhkaisemisen yhteydessa. Neula vaihdettiin uuteen malliin, jossa ndytteenottoreika on

injektioneulan sivussa. Neulan vaihdon jalkeen pumppausongelmat katosivat.
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Suurin osa taman opinnaytetyon mittauksista on tehty viallisella neulalla ja neulanvaihto
tehtiin vasta lahes kaikkien mittausten jalkeen. Neulan osittaisella tukkiutumisella on
saattanut olla vaikutusta tuloksiin erityisesti kationianalyyseissa, koska nédyte kulkee
pidemméan matkan injektioneulalta kationilooppiin. Kalibrointisuorien standardinaytteet
on kuitenkin ajettu samoissa olosuhteissa kuin muut naytteet, joten neulan mahdollisesti
aiheuttamat virheet tuloksiin ovat saattaneet vaikuttaa yhtda lailla standardeihin ja

naytteisiin.

6.1.2 Suodatinyksikko

Osa jatevesindytteista ajetaan laimentamattomina, koska jokin naytteesta tutkituista
ionipitoisuuksista on erittdin pieni. Laimentamattomat ndytteet ovat kuitenkin erittdin
likaisia ja niissé on suuri mé&éard muita ioneja ja epapuhtauksia. Téallaisia ndytteitd ovat
erityisesti Polson jatevedenpuhdistamon prosessindytteet, joissa on yleensa erittdin pieni
nitraattipitoisuus ja erittdin suuri pitoisuus muita ioneja. Kun laimentamattomia Polson
jatevesinaytteita ajettiin, havaittiin kationien kontrollindytteiden tulosten pienentymisté
seuraavissa ajoissa. Kontrollindytteiden tulokset palasivat normaaleiksi kun

suodatinyksikon suodatinpaperi vaihdettiin Polson nédytteiden ajamisen jalkeen.

Jatevesien tarkkaa koostumusta on vaikea selvittdd, koska niissa voi olla suuri méaara
erilaisia yhdisteitd. Tarkka syy kontrollien poikkeamalle ei selvinnyt. Likaisissa
jatevesinaytteissd saattaa olla joitakin sellaisia komponentteja, jotka jaavat
suodatinpaperiin  ja hdiritsevat analyyseja. Laimentamattomat jatevesindytteet
suodatetaan jatkossa kahdesti ruiskusuodattimella. Muut néytteet suodatetaan
normaalisti vain kerran. Lis&ksi autosamplerin suodatinyksikon suodatinpaperin
vaihtovélia lyhennettiin kahteen viikkoon ja se pyritddn vaihtamaan erittdin likaisten
néytteiden jalkeen. Tarvittaessa voidaan harkita likaisten naytteiden esikésittelya, joka

voidaan tehd& esimerkiksi ioninvaihtopatruunoilla.

Laimentamattomien jatevesien kohdalla havaittiin my6s pienid méaarié carry-overia, eli
0sa ndytteen ioneista jai seuraavaan néytteeseen. Carry-overin mééara oli yleensa 0,1-

0,5% edellisen ndytteen pitoisuudesta. Esimerkiksi 300 mg/l sulfaattia sisaltaneesta



21

jatevesindytteestda saattoi jd&da 1 mg/l sulfaattia ndytteen jalkeen ajettuun
nollandytteeseen. Laimentamattomien jatevesindytteiden jalkeen ajetaan jatkossa MilliQ
vesi ndytteend kolonnin  huuhtelemiseksi. Liséksi havaittiin, ett4d uusista
suodatinpapereista irtoaa pienia maarid kaliumia ja magnesiumia. Suodatinpaperin
vaihdon jalkeen ajetuissa nollandytteissa l6ytyi pienid kalium- ja magnesiumjaamié.
Myos kontrollindytteiden tulokset olivat normaalia suurempia suodatinpaperinvaihdon
jalkeen. Jatkossa suodatinpaperit liotetaan MilliQ vedessa ennen kayttoonottoa
vuorokauden ajan ja vaihdon yhteydessé suodatinpaperin lapi pumpataan MilliQ-vetta

ennen naytteiden ajoa.

6.1.3 Kalkki kalsiumin lahteena

Vedenpuhdistusprosessissa kaytetadn kalkkia pH:n sdatamiseen. Ruskon kalkkitilat ovat
suoraan ionikromatografin ylapuolella ylemmaéssa kerroksessa ja kalkki levidé helposti.
Kalsiumkontaminaatiota 16ydettiin esimerkiksi vanhasta typpihaposta. Kalkkipdly on
mahdollinen kalsiumin lédhde ja se vaikeuttaa kalsiumin analyysia laboratoriossa.
Jatkossa ionikromatografi siirretddn toiseen paikkaan, jossa se ei ole suoraan
kalkkitilojen alapuolella. Kalkkipolyn yleisyyden wvuoksi kalsiumin mittaamisessa

taytyy noudattaa erityista varovaisuutta.

6.1.4 Vikavirtasuoja

Laite kytkettiin UPS-vikavirtasuojaan sédhkokatkosten ja virtapiikkien varalta, jonka
jalkeen  havaittiin  vikavirtasuojan  vaikuttaneen laitteen sisdiseen kelloon.
Vikavirtasuojan kéayttdonoton jalkeen laitteen kello alkoi kdyda 3,6 kertaa oikeaa aikaa
hitaammin. Injektio-ohjelmassa 2% minuutin injektio muuttui 9 minuutin injektioksi.
Ongelman lopullinen syy ei selvinnyt, mutta ilmeisesti laite mittaa sisdisen aikansa
sahkovirran taajuudesta ja vaatisi toisenlaisen vikavirtasuojan. Laitteen siséinen kello

palautui normaalisti heti vikavirtasuojan poistamisen jéalkeen.
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6.1.5 Eluenttisuodattimet

Eluenttiséilidissa oli laitteen kayttdonoton alussa eluenttiletkujen péissa suodattimet,
joiden tehtévana oli poistaa eluentin epdpuhtauksia. Laitetta kdyttdessd havaittiin, ettd
suodattimien pinnalle kertyi ilmakuplia. Liséksi laitteen eluentin pumpun paine
pienentyi satunnaisesti kesken ajoa selittdmattomésta syystd. On mahdollista, ettd
eluenttisuodattimen pinnalle kertynyt ilmakupla on pdadssyt suodattimesta lapi ja
kulkeutuessaan pumppuun aiheuttanut paineen laskun. Paineen laskemiseen liittyvét
ongelmat katosivat suodattimien poiston jalkeen. Eluenttien valmistuksessa kéytettava
MilliQ vesi on puhdasta ja siitd poistetaan kaasut vakuumisuodatuksella ennen eluentin
valmistusta. Eluentit laimennetaan puhtaista kaupallisista liuoksista. Liséksi
eluenttisailion ja kolonnin vélilld on inline-suodattimia ja esikolonni. Eluenttisailion
suodattimet katsottiin naista syisté tarpeettomiksi.. Suodattimen puuttumisen vuoksi on
kuitenkin tarke&a, ettd eluenttien valmistuksessa noudatetaan erityista huolellisuutta.

6.2 Yleista validoinnista

Validoinnissa kaytetyt liuokset on esitetty liittessd 1. Kationien kontrolliliuoksesta
kaytetdan tassd tyossa lyhennettd MultiCat. Anionien kontrolliliuoksista (2kpl)
kaytetddn lyhenteitd MultiAnioni ja MultiElement. Jokaisen ndytesarjan alussa ja
lopussa ajettiin ultrapuhdas MilliQ vesi néytteend. Liséksi erittdin likaisten
laimentamattomien jatevesien jalkeen ajettiin ultrapuhdas vesi nédytteena. Nitraatti on

laskettu tuloksissa nitraattityppend ja ammonium ammoniumtyppena.

Liuosten valmistuksessa ja huuhteluissa kéaytetty vesi valmistettiin Millipore Milli-Q
Gradient Water Purification laitteella, joka oli asennettu 12.9.2012. Jatevesien
laimentamiseen kaytettiin laboratorion sisdisesti kalibroituja Oxford macro-set pipetteja.
Lisdksi ké&ytettiin Blaubrandin valmistamia As-luokan tayspipetteja ja A-luokan
mittapulloja.  Kationianalyysien  standardi- ja kontrolliliuokset  valmistettiin

muovipulloihin ja anionianalyysien liuokset lasipulloihin.
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6.3 Tarkkuus ja toistettavuus

Tarkkuutta ja toistettavuutta tutkittiin ajamalla sertifioituja kontrollindytteita eri
pitoisuuksilla useina eri paivind. Kationikontrollina kéytettiin MultiCat-liuosta, josta
tehtiin  66x, 100x, 200x ja 333x laimennukset. Anionikontrolleina kaytettiin
MultiAnioni- ja MultiElement-liuoksia. MultiAnioni-liuoksesta tehtiin 20x ja 200x
laimennukset. MultiElement liuoksesta tehtiin 6,66x ja 20x laimennukset. Liuosten
tiedot on kerrottu liittessa 1. Mitattujen tuloksien keskiarvoa verrattiin teoreettiseen

pitoisuuteen. Rinnakkaisnaytteisté laskettiin absoluuttinen ja suhteellinen keskihajonta.

6.4 Selektiivisyys ja toistettavuus

Menetelman selektiivisyyttd ja toistettavuutta tutkittiin saantokokeilla. N&ytematriisiin
lisattiin eri madrid standardiliuosta, jolla on tunnetut pitoisuudet tutkittavia ioneja.
Kustakin pitoisuudesta valmistettiin 3 rinnakkaisndytettd ja jokainen nayte ajettiin
kolmena eri paivana. Yhteensa jokaisesta naytteesta ajettiin 9 rinnakkaisanalyysia, jotka
oli valmistettu kolmessa eri mittapullossa. Kationien saantokokeissa tutkittavaksi
naytteeksi valmistettiin 2 litran 20x laimennos Raholan esiselkeytetysta jatevedesta.
Néayte valittiin, koska siina oli tyypillinen naytematriisi tutkittaville jatevesille ja sen
kationipitoisuudet olivat sopivia lisdyskokeisiin. Laimennettua standardiliuosta (100x)
lisattiin 2,5ml, 5ml ja 10ml kustakin lisdysmaarastd kolmeen rinnakkaiseen 100ml
naytepulloon. Lisdysliuoksena kaytettiin Fluka Multi Cation Standard 1 for IC-
standardia. Naytteet laimennettiin tutkittavalla jatevedella ja verrattiin saatuja

mittaustuloksia laskettuihin teoreettisiin pitoisuuksiin.

Anionien saantoa tutkittiin lissdméalla eri méarid standardiliuosta Ruskon raakaveteen,
joka on Roineen jdrven vettd. Jarvivesi valittiin néytteeksi, koska anioneja tutkitaan
usein pohjavesistd ja talousvesistd. Néaytteelld oli lisdyskokeisiin sopivat pitoisuudet
tutkittavia anioneja, mutta siiné ei ollut lainkaan nitraattia. Nitraattia ei yleensa 10ydy
mistdén talousvesistd. Jarviveden matriisi on tyypillinen sellaisille naytteille, joista
tutkitaan fluoria, kloridia, nitraattia ja sulfaattia. Tarkoituksena oli selvittdd, nakyisiko

lisdys oikeana pitoisuuden suurenemisena. Standardiliuosta lisattiin 5ml, 10ml ja 20ml
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kustakin lisdyksesta kolmeen rinnakkaiseen 100ml mittapulloon. Lisdysliuoksena

kaytettiin anionien perusliuosta (Liite 2 kohta 5.1).



25

7 VALIDOINNIN TULOKSET

7.1 Tarkkuuskokeet

Tarkkuutta ja toistettavuutta tutkittiin sertifioitujen vertailumateriaalien kautta.
Kationimittausten tulokset 16ytyvat taulukosta 1 ja anionimittausten tulokset taulukosta
2. Néaytteista on kerrottu rinnakkaisndytteiden maara, minimi- ja maksimipitoisuudet ja
suhteelliset keskihajonnat. Naytteet on merkitty taulukkoon kunkin ionin osalta
pitoisuuden mukaisessa jarjestyksessa. Osa tutkituista pitoisuuksista oli erittdin pienia
mittausalueeseen verrattuna, koska kontrollit olivat yhdistelméstandardeja. Esimerkiksi
kloridin pienin mitattu pitoisuus 0,15 mg/l on Kloridin maaritysrajan alapuolella.
Pienissd pitoisuuksissa on odotettavissa suurempi keskihajonta. Kaliumin tuloksissa
333x laimennoksessa keskihajonta oli suuri ja tulosten keskiarvo selvasti teoreettista
suurempi. Suurin mitattu tulos oli 30% teoreettista suurempi. Poikkeavia mittauksia
ennen oli tehty laitteen suodatinkennon suodatinpaperin vaihto. 6.1.2 luvussa on
kerrottu tarkemmin suodatinpaperista perdisin olevista kaliumjaanteistd. On
todenndkdistd, ettd 333x ndytteiden poikkeamat kaliumtuloksissa johtuvat

suodatinpaperista. My6s natriumin pienimmasta pitoisuudesta tuli teoreettista suurempi.
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Niiyte .Te.oreettinen Keskiarvo | Min Max | STD | STD- ol
pitoisuus (mg/l) (mg/l) (mg/l) | (mg/l) | (mg/l) | %
Natrium
MultiCat 333x 0,60 0,634 0,608 | 0,687 | 0,02 | 3,2% | 14
MultiCat 200x 1,00 1,045 0,988 | 1,094 | 0,05 |49% | 5
MultiCat 100x 2,00 2,051 1,887 | 2,160 | 0,05 | 2,5% | 27
MultiCat 66x 3,00 3,001 2943 | 3,059 | 0,04 [14% | 5
Ammonium
MultiCat 333x 0,93 0,919 0,902 | 0,935 | 0,01 | 1,1% | 14
MultiCat 200x 1,55 1,488 1,456 | 1,515 | 0,02 | 1,7% | 5
MultiCat 100x 3,106 3,104 2,881 | 3,211 | 0,06 | 1,8% | 27
MultiCat 66x 4,66 4,622 4539 | 4,732 | 0,07 | 15% | 5
Kalium
MultiCat 333x 0,60 0,648 0,592 | 0,783 | 0,05 | 8,2% | 14
MultiCat 200x 1,00 1,008 0,979 | 1,050 | 0,03 | 2,8% | 5
MultiCat 100x 2,00 2,046 1,882 | 2,248 | 0,06 |3,1% | 27
MultiCat 66x 3,00 3,001 2947 | 3,124 | 0,07 | 23% | 5
Kalsium
MultiCat 333x 3,00 2,968 2,806 | 3,092 | 0,09 |3,0% | 14
MultiCat 200x 5,00 5,087 4991 | 5184 | 0,07 | 15% | 5
MultiCat 100x 10,0 10,65 9,287 | 12,10 | 0,71 | 6,6% | 27
MultiCat 66x 15,0 15,46 15,20 | 15,66 | 0,20 | 1,3% | 5
Magnesium
MultiCat 333x 0,60 0,602 0,577 | 0,623 | 0,01 | 22% | 14
MultiCat 200x 1,00 1,010 0,994 | 1,023 | 0,01 [13% | 5
MultiCat 100x 2,00 2,078 1837 | 2,391 | 0,11 | 53% | 27
MultiCat 66x 3,00 3,037 2,982 | 3,102 | 0,05 |15% | 5
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Teoreettinen | Keski- _ STD | STD-
pitoisuus arvo Min | Max (mg/l) % !
Fluoridi
MultiAnioni 20x 1,0 1,023 | 0,951 | 1,060 | 0,023 | 2,3% | 43
MultiElement 6.66x 0,45 0,449 | 0,424 | 0,469 | 0,012 | 2,7% | 26
MultiElement 20x 0,15 0,145 | 0,137 | 0,151 | 0,004 | 25% | 11
MultiAnioni 200x 0,10 0,105 | 0,102 | 0,107 | 0,002 | 1,7% | 14
Kloridi
MultiAnioni 20x 15 1,472 | 1,389 | 1,575 | 0,038 | 2,6% | 43
MultiElement 6.66x 15 1,485 | 1,423 | 1,578 | 0,052 | 3,5% | 26
MultiElement 20x 0,5 0,487 | 0,450 | 0,507 | 0,017 | 3,4% | 11
MultiAnioni 200x 0,15 0,165 | 0,143 | 0,209 | 0,021 | 12,6% | 14
Nitraatti
MultiAnioni 20x 1,13 1,150 | 1,088 | 1,193 | 0,022 | 1,9% | 43
MultiElement 6.66x 0,678 0,668 | 0,627 | 0,695 | 0,017 | 25% | 26
MultiElement 20x 0,226 0,209 | 0,191 | 0,222 | 0,012 | 57% | 11
MultiAnioni 200x 0,113 0,099 | 0,097 | 0,101 | 0,001 | 1,3% | 14
Sulfaatti
MultiAnioni 20x 7,5 7,706 | 7,292 | 8,027 | 0,151 | 2,0% | 43
MultiElement 6.66x 3,0 3,046 | 2,793 | 3,312 | 0,115 | 3,8% | 26
MultiElement 20x 1,0 0,965 | 0,903 | 1,004 | 0,036 | 3,7% | 11
MultiAnioni 200x 0,75 0,721 | 0,691 | 0,756 | 0,023 | 3,2% | 14
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7.2 Kationien saantokokeet

Taulukossa 3 on kuvattu saantokokeiden tulokset. Saannot on laskettu kaavalla (3).
Natriumin ja ammoniumin mittauksissa saanto oli 107,6% pienimmassa lisayssarjassa.
Keskihajonnat olivat pienid ja saanto ldhempéna 100% kahdessa muussa lisdyssarjassa.
Poikkeama teoreettisesta tuloksesta on Kkaikissa sarjoissa samaa suuruusluokkaa.
Todennakoisesti kaikkiin sarjoihin on tullut jostain l&hteesta pieni maara tutkittavia
kationeja. Kaliumin lisdyskokeissa saanto oli kaikissa naytesarjoissa lahelld 100% ja

keskihajonta oli pienté.

Saanto (%) = % * 100% 3)

3

C; = tunnetulla lisdyksella tehtyjen ndytteiden pitoisuuksien keskiarvo
C, = Néytteen pitoisuus ilman lisdysta

Cs = Tunnetun lisédyksen laskennallinen pitoisuus

Kalsiumin saannot poikkesivat enemmén teoreettisesta kuin muiden kationien.
Kalsiumista saatiin teoreettista suurempia ja magnesiumista teoreettista pienempia
tuloksia. Liséksi kalsiumin ja magnesiumin mittauksissa oli suuria vaihteluja. Erdadn
toisena paivénd ajetun ndytesarjan RE-ndytteessa kalsium- ja magnesiumpitoisuudet
olivat alle 50% verrattuna muihin kahdeksaan saman néytteen rinnakkaismittaukseen.
Poikkeava ndyte oli ndytesarjan ensimmadisend ajettu nayte. Nayte poistettiin
naytesarjasta alkuperdisen nadytteen pitoisuutta laskettaessa. Suuri poikkeama kalsium-
ja magnesiummittauksissa viittaa siihen, ettd jokin tuntematon tekija aiheuttaa virheita.
Saantokokeet tehtiin 6.1.1 luvussa kuvatulla viallisella neulalla. Neulan tukkeutuminen
on saattanut vaikuttaa saantokokeiden tuloksiin. Naiden tuloksien perusteella
kationimittauksissa oli ongelmia erityisesti kalsiumin ja magnesiumin suhteen.
Kaliummittaukset onnistuivat hyvin neulasta huolimatta. Natriumin ja ammoniumin

mittaukset antoivat hieman teoreettista pitoisuutta suurempia tuloksia.
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Nayte ja | Teoreettinen Mit'attu )
lisays Ditoisuus pitoisuus | Min Max | Saanto% (ka) | STD-% | kpl
(ka)

Natrium
RE 2,822 2,727 | 2,953 2,4% 9
RE+2.5ml 3,251 3,289 3,239 | 3,325 107,6% 1,0% 9
RE+5ml 3,681 3,710 3,642 | 3,760 102,9% 1,3% 9
RE+10ml 4,540 4,548 4,458 | 4,614 100,4% 1,4% 9

Ammonium

RE 2,428 2,325 | 2,517 2,8% 9
RE+2.5ml 3,143 3,201 | 3,125 | 3,249 107,4% 1,5% 9
RE+5ml 3,859 3,913 3,803 | 3,972 103,5% 1,7% 9
RE+10ml 5,291 5,338 5,218 | 5411 101,5% 1,5% 9

Kalium
RE 1,075 1,048 | 1,143 2,71% 9
RE+2.5ml 1,548 1,557 1,536 | 1,58 101,8% 0,9% 9
RE+5ml 2,021 2,027 1,993 | 2,056 100,6% 1,1% 9
RE+10ml 2,968 2,957 2,902 | 2,993 99,5% 1,3% 9

Kalsium
RE 1,449 1,234 | 1,573 7,1% 8
RE+2.5ml 3,913 3,772 3,605 | 3,876 94,4% 2,8% 9
RE+5ml 6,377 6,249 6,149 | 6,306 97,4% 1,0% 9
RE+10ml 11,304 11,179 | 11,02 | 11,28 98,8% 0,7% 9

Magnesium

RE 0,427 0,394 | 0,450 4,5% 8
RE+2.5ml 0,916 0,938 | 0,911 | 0,993 104,4% 3,5% 9
RE+5ml 1,405 1,409 1,386 | 1,431 100,3% 1,1% 9
RE+10ml 2,384 2,389 2,352 | 2,408 100,2% 0,7% 9
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7.3 Anionien saantokokeet

Taulukossa 4 on kuvattu anionien saantokokeiden tulokset. Alkuperdisend néytteena
kaytetysta Ruskon raakavedestd ei l0ytynyt lainkaan nitraattia. Anionien
saantokokeiden tulokset olivat hyvid. Kaikkien naytesarjojen saannot olivat lahella
100% ja keskihajonta oli l&dhes kaikissa sarjoissa alle 1%. Nitraatin pienimmé&ssé
lisdysndytteesséd oli hieman suurempi keskihajonta 1,8% kuin muissa analyyseissa.
Myos anionien saantokokeet tehtiin luvussa 6.1.1 kuvatulla viallisella neulalla, mutta
kokeet onnistuivat neulasta huolimatta hyvin. Nayteliuos kulkee injektioneulalta
anionilooppiin  huomattavasti lyhyemméan matkan kuin kationilooppiin. On
todenndkaistd, ettd neulan tukkeutuminen ei ole vaikuttanut anionien tuloksiin yhta

lailla kuin kationien tuloksiin.

7.4 Maaritysrajat ja toteamisrajat

Madritysrajat ja toteamisrajat madritettiin sellaisen laimennetun kontrollindytteen
keskihajonnasta, jossa analysoitavilla ioneilla on pieni pitoisuus. Anionindytteeksi
valittiin MultiAnioni 200x ja kationindytteeksi MultiCat 333x. Lasketut rajat on esitetty
taulukossa 5. Kaliumin maéaritysrajasta tuli varsin korkea. Kaliummittausten suuri
keskihajonta voi liittyd esimerkiksi 7.1 luvussa esitettyihin syihin. Kaliumin
mittaustarkkuutta voidaan parantaa kehittdméalld mittausmenettelyjé esimerkiksi 6.1.2
luvussa mainittujen suodatinpaperiin liittyvien seikkojen suhteen. Kalsiumin tulosten
hajonta ja siitd seuraava hieman suuri maaritysraja saattaa johtua ymparistosta tulevasta
kalkista.
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Nayte ja | Teoreettinen I?/Iit.attu _
lisays Ditoisuus pitoisuus | Min Max | Saanto% (ka) | STD-% | kpl
(ka)
Fluoridi
RR 0,120 0,118 | 0,121 097% | 9
RR+5ml 0,314 0,312 0,311 | 0,314 99,1% 0,35% | 9
RR+10ml 0,508 0,503 0,499 | 0,505 98,6% 0,39% | 9
RR+20ml 0,896 0,888 0,882 | 0,893 99,0% 0,40% | 9
Kloridi
RR 3,247 3,231 | 3,265 0,36% | 9
RR+5ml 5,585 5,585 5,565 | 5,601 100,0% 0,25% | 9
RR+10ml 7,922 7,935 7,901 | 7,958 100,2% 0,27% | 9
RR+20ml 12,60 12,73 12,68 | 12,79 101,3% 0,30% | 9
Nitraatti
RR - - - - - 9
RR+5ml 0,5648 0,5636 0,549 | 0,575 99,8% 1,8% 9
RR+10ml 1,1296 1,124 1,106 | 1,138 99,5% 1,0% 9
RR+20ml 2,2592 2,260 2,239 | 2,277 100,0% 0,6% 9
Sulfaatti
RR 7,9839 7,921 | 8,018 041% | 9
RR+5ml 10,0845 10,0996 | 10,053 | 10,132 100,6% 0,29% | 9
RR+10ml 12,1855 12,1882 | 12,135 | 12,249 100,1% 0,29% | 9
RR+20ml 16,3871 16,4032 | 16,344 | 16,455 100,2% 0,25% | 9
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TAULUKKO 5. Madritys- ja toteamisrajat

Analyysi | Toteamisraja | Madritysraja | Analyysi Toteamisraja | Maaritysraja
(mg/l) (mg/l) (mg/l) (mg/l)
F 0,006 0,02 Na* 0,06 0,20
CI 0,063 0,21 NH,;"-N 0,03 0,10
NO3-N 0,003 0,01 K" 0,16 0,53
SO~ 0,069 0,23 ca™ 0,26 0,88
Mg®* 0,04 0,13

7.5 Kalibrointisuorat

Laitteen kalibrointisuorat uusitaan noin kuukauden valein. Jokaisessa ajossa on mukana
yksi kalibrointiliuoksen laimennuksista sertifioitujen kontrollindytteiden lisaksi.
Liittessa 3 on esitetty erdan Kkalibroinnin tulokset. Taulukossa 6 on kooste
kalibrointisuorien selitysasteista (R?. Selitysaste on korrelaatiokertoimen nelio ja sen
tulisi olla mahdollisimman l&hell& yht4. Kationien kalibrointisuorat ovat lineaarisia, kun
taas anionien suorat ovat kvadraattisia suppressorin vaikutuksen vuoksi. Suurimmassa

osassa Kalibrointisuorista korrelaatiokerroin oli erittain lahelld yhtd. Kalsiumin ja

magnesiumin  kontrollikayrissa oli

yleisesti

korrelaatiokertoimet kuin muiden ionien kontrollikayrissa.

TAULUKKO 6. Kalibrointisuorien korrelaatiokertoimet

enemman hajontaa ja pienemmat

Analyysi R Analyysi R
F 0.999935 Na* 0.999914
Ccr 0.999934 NH,"-N 0.999995
NO3-N 0.999983 K* 0.999915
S04* 0.999971 Cca® 0.99767
Mg~ 0.99984
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7.6 Retentioajat

lonien retentioaikoja seurattiin 3 kuukauden ajan. Kationien retentioajat muuttuivat
merkittavasti, kun otettiin kayttédn uusi pullo dipikoliinihappoa eli DPA:ta. Samalla
kationieluentin johtokyky muuttui noin 720 pS/cm:std 705:een pS/cm. llmeisesti
laitteen mukana tullut avattu dipikoliinihappo oli p&assyt vanhenemaan. Retentioajat
pysyivat stabiileina uuden dipikoliinihapon kayttoonoton jalkeen. Taulukoissa 7 ja 8 on
esitetty anionien ja kationien retentioajat. Naytteind on jatevesid, standardiliuoksia,

kontrollindytteitd ja talousvesia.

Kationeista on esitetty vertailun vuoksi vanhentuneen dipikoliinihapon retentioajat.
Tuoreella dipikoliinihapolla retentioajat olivat pidemmat alkuperdiseen verrattuna.
Kalsiumin ja magnesiumin kohdalla esiintyy paljon vaihtelua retentioajoissa, koska
retentioaika ja piikin muoto vaihtelevat ionin konsentraation mukaan. Suuremmilla

pitoisuuksilla retentioaika lyhenee.

TAULUKKO 7. Anionien retentioajat 18.6 — 2.9.2013

F Cl | NOs-N | SO,
Keskiarvo 3,48 5,25 9,12 14,39
Minimi 3,38 5,22 8,9 13,93
Maksimi 3,61 5,57 9,51 14,56

Keskihajonta 0,01 0,03 0,1 0,09

Keskihajonta% | 0,38% | 0,53% | 1,14% | 0,64%

Analyysiméaara 326 336 321 334




TAULUKKO 8. Kationien retentioajat 23.7 — 2.9.2013
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Na* NH,*-N K* Ca”* Mg**
Keskiarvo (vanha
5,55 6,17 8,32 14,25 18,05
DPA 29.5-22.7)
Keskiarvo (uusi
5,67 6,33 8,49 15,73 19,65
DPA 23.7-2.9)
Minimi 5,56 6,19 8,27 13,72 17,6
Maksimi 6,01 6,49 8,94 17,04 21,09
Keskihajonta 0,07 0,05 0,08 0,79 0,61
Keskihajonta-% 1,32% 0,83% 0,95% 5,04% 3,11%
Analyysimaara 443 375 442 342 414
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8 VERTAILUKELPOISUUS

8.1 Ammoniumvertailu

Ammoniumia tutkitaan  Viemadrilaitoksen laboratoriossa  spektrofotometriselld
indofenolimenetelmé&lld.  Indofenolimenetelmdn kuvaus on liittessa 4. Uuden
ionikromatografin ammoniummittauksia verrattiin alustavasti indofenolimenetelman
tuloksiin.  Vanhan ionikromatografin mittaukset tehtiin Tampereen Vesi (2008)
menetelmédohjeen mukaisesti. Indofenolimenetelméssé naytteité ei suodateta toisin kuin
IC-menetelmassa. lonikromatografiset menetelmét mittaavat vain néytteen liuenneita
ioneja, koska kiintoaineessa kiinni olevat ionit poistuvat suodatuksen yhteydessé.
Mikali IC:11a halutaan mitata myods liukenemattomia ioneja, tulisi naytteet kasitella
ennen suodatusta. Sikéli indofenolimenetelm& ei ole taysin vertailukelpoinen IC-
menetelmiin likaisia ndytteitd analysoidessa, mutta sitd voidaan pitdd suuntaa antavana.
Likaisissa jatevesissa ammoniumia voi poistua Kiintoaineen suodatuksen yhteydessa.
Siita syysta indofenolimenetelmén tuloksen voi olettaa olevan yleensé véahintdan hieman
suurempi  kuin ionikromatografisen menetelman tuloksien. Uuden IC:n tuloksia

verrattiin sekd indofenolimenetelméaan ettd vanhaan laitteeseen.

Vanhassa laitteessa naytepiikkien erotuskyky oli heikko. Kuvassa 7 on esimerkki
vanhan ionikromatografin ammoniumpiikistd. Ensimmadinen piikki on natrium
retentioajalla 4,3. Toinen piikki on ammonium retentioajalla 5 ja kolmas piikki on
kalium retentioajalla 6,5. Ammoniumpiikki menee paallekkain viereisen natriumpiikin
kanssa ja jatkuu pitkalle kaliumpiikkiin saakka. Kuvassa 8 on esimerkki uuden
Metrohmin ionikromatografin ~ erotuskyvysté. Piikit  erottuvat  uudessa
ionikromatografissa erittdin  hyvin. Vanhassa ionikromatografissa ammoniakin
kalibrointi tehtiin piikin korkeuden mukaan, mutta on oletettavaa, ettd viereiset natrium-
ja  kaliumpiikit ovat saattaneet vaikuttaa ammoniakin tuloksiin.  Lisaksi
ammoniumpiikeissa havaittiin vaihtelua pinta-alan ja leveyden suhteen erityyppisissa
naytteissa, vaikka korkeus ja korkeuden mukaan laskettu konsentraatio olivat
samansuuruisia. N&istd syistd vanhan ionikromatografin tuloksien oikeellisuudesta ei

voida olla varmoja.
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Kuva 8. Uuden laitteen natrium-, ammonium- ja kaliumpiikit

Kuviossa 1 on esitetty regressiosuora vanhan ja uuden laitteen vélill4. Regressiosuorissa
uuden laitteen tulokset ovat x-akselilla ja vertailtavan menetelman tulokset y-akselilla.
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Jos regressiosuoran kulmakerroin on lahelld yhtd, antavat menetelmét samansuuruisia
tuloksia. Korrelaatiokerroin ja siitd laskettava selitysaste kuvaavat tulosten
vaihtelevuutta menetelmiéd verrattaessa. Uuden ionikromatografin tulokset ovat noin
10% pienempid kuin vanhalla mitatut. On epéiltavad, ettd luvussa 6.1.1 kuvatut
injektioneulan viat ovat saattaneet vaikuttaa tuloksiin. Kuviossa 2 on esitetty
regressiosuora indofenolimenetelmén ja uuden ionikromatografin tulosten valilla.
Menetelmét vastaavat hyvin toisiaan tarkasteltaessa sellaisia naytteitd, joiden pitoisuus
on valilla 0 — 15 mg/l. Naytteet olivat kasiteltyja jatevesid, joissa kiintoaine- ja
ammoniumpitoisuudet ovat pienid. Uuden laitteen tulokset poikkeavat paljon néaytteissa,
joissa mitattu ammoniumpitoisuus on yli 30 mg/l. Suurien pitoisuuksien ndytteet ovat

kasitteleméattomid ja esikasiteltyja jatevesid, joissa on paljon kiintoainetta.

Tuloksien perusteella uusi laite mittasi pienempid ammoniumpitoisuuksia verrattuna
sek& vanhaan ionikromatografiin ettd indofenolimenetelméaan, kun naytteind oli paljon
kiintoainetta siséltavid jatevesia. Kaésiteltyjen puhtaiden jatevesien kohdalla uusi laite
antoi samansuuruisia tuloksia kuin indofenolimenetelmé. Kyseisia naytteita ei voitu
mitata vanhalla ionikromatografilla, koska sen erotuskyky ei riittdnyt niin pieniin
pitoisuuksiin. Osa menetelmien vélisesta poikkeamasta johtunevat 6.1.1 luvussa
kuvatuista injektioneulaan liittyvista ongelmista. Indofenolimenetelma mittaa kuitenkin
kaikkea néaytteessda olevaa ammoniumia, kun taas ionikromatografi mittaa vain
liuenneita ioneja. Osa menetelmien vélisestd erosta voi johtua kiintoaineessa kiinni

olevasta ammoniumista.
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KUVIO 2. Ammoniumin regressiosuora uuden IC:n ja indofenolimenetelman vélilla
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8.2 Anionivertailu

Naytteind oli seka jatevesid ettd talousvesid. Anionimittausten regressiokayrat on
esitetty kuvioissa 3, 4, 5 ja 6. Taulukossa 9 on regressioanalyysien kooste. Kloridin,
nitraatin ja sulfaatin kohdalla vanha ja uusi ionikromatografi antoivat samankaltaisia
tuloksia, koska taulukossa 9 esitetyt kulmakertoimet ovat lahella yhtd. Fluoridilla on
selvasti pienempi kulmakerroin. Mitatuissa vesinadytteissa oli pieni fluoridipitoisuus ja
konsentraatiot sijoittuivat kalibrointikdyréan alkup&éhén. Useimmissa vesindytteisséa
fluoridipitoisuus oli alle laitteen maaritysrajan, joten vertailundytteitda ei saatu yhta

paljon kuin muissa anioneissa.

TAULUKKO 9. Anionivertailun regressioanalyysin kooste

Analyysi | Kulmakerroin R® Analyysimaara
F 0.927 0.9521 18
Ccr 1,0034 0,9996 62
NO3-N 1.0283 0.9975 54
S047 1.0034 0.9996 62
0,45 -
0,4 - y =X
0,35 - A
0,3 - y =0,927x + 0,0036
= R?=0,9521
B
E£025 -
3
S 02 -
2
0,15 - ®
01 - N
o
0,05 - *
0 T T T T T T T T 1
0 005 01 015 02 025 03 035 04 045
Metrohm (mg/I1)

KUVIO 3. Fluoridin regressiosuora
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KUVIO 6. Sulfaatin regressiosuora

8.3 Kovuusvertailu

Kalsiumia ja magnesiumia ei ollut mitattu laboratoriossa aikaissmmin. Niiden kohdalla
suoritettiin  alustava vertailu talousvesilaboratorion kovuustitraukseen. Kovuus
madritettiin ndytteistd EDTA-titrauksella, jonka tuloksia verrattiin mitattujen kalsium-
ja magnesiumpitoisuuksien avulla lasketulla kovuudella. Kovuustitrauksen menetelmé
on esitetty liittessd 5. Kovuutta tarkasteltiin viitend eri péivand 22 naytteesta.
Menetelmia verrattiin Excelin regressioanalyysilla. Regressiosuora on esitetty kuviossa
7. Korrelaatio- ja kulmakerroin on esitetty taulukossa 10. Kovuus maééritettiin

saksalaisina kovuusasteina (°dH).

Kulmakertoimen tulisi olla mahdollisimman l&hellda yht&, jotta tulokset vastaisivat
toisiaan ja se oli 0,99. Néiden tulosten perusteella titrauksen ja 1C:n kovuusmittaukset
olivat vertailukelpoisia, mutta ionikromatografin tulokset olivat hieman suurempia kuin
titrauksen. Titratessa silmamaaraisesti tiettyyn vérisdvyyn tulokset saattavat vaihdella

analyysin tekijan kaden jaljen vuoksi.
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TAULUKKO 10. Kovuuden regressioanalyysi

Selitysaste R’ 0,9979
Kulmakerroin 0,9909
Analyysimaara 23 kpl
8 -
7 .

y =0,9909x + 0,0098
R?=0,9979 *

Titraus (°dH)
N

Metrohm (°dH)

KUVIO 7. Kovuusvertailun regressiosuora

8.4 Kationien vertailututkimus

Vanhalla ionikromatografilla ei tehty kalsiumin, magnesiumin, kaliumin ja natriumin
analyyseja erilaisten ongelmien vuoksi. Talousvesistd ja pohjavesistda on lahetetty
néytteet 4-6 Kkertaa vuodessa Kokemdaenjoen vesiston vesiensuojeluyhdistykselle
analysoitaviksi, jossa ne tutkitaan induktiivisesti kytketyll4 plasmalla (ICP). Uudella
ionikromatografilla tehtiin kationianalyysit KVVY:lle lahetetyistd néytteista vertailun
vuoksi. KVVY ilmoitti tulokset kahdella merkitsevallda numerolla, joten tulosten

pyoristys voi aiheuttaa virhetté vertailussa.
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Kuviossa 8, 9, 10, ja 11 on esitetty vertailujen regressiosuorat. Uuden ionikromatografin
tulokset on asetetettu X-akselille ja alihankkijan ilmoittamat tulokset Y-akselille.
Taulukossa 11 on kooste suorien korrelaatio- ja kulmakertoimista. Kulmakertoimen
tulisi olla mahdollisimman lahelld yhtd, ettd tulokset ovat vertailukelpoisia.
Kulmakerroin on lahelld yhtd kaliumin suhteen. Natriumissa, kalsiumissa ja
magnesiumissa ionikromatografi antaa hieman suurempia tuloksia. Natriumin suhteen
tulokset olivat johdonmukaisesti suurempia. Magnesiumin ja kalsiumin tuloksissa oli
enemman hajontaa, joka nakyy pienempina korrelaatiokertoimina. lonikromatografi
mittasi useimmissa analyyseissa hieman suurempia arvoja alihankkijan ilmoittamiin
tuloksiin nahden. Osa erosta saattaa tulla alihankkijan tulosten pyoristdmisesta.
lonikromatografin toimintakunnosta ei ole varmuutta vertailuajalta 6.1 kohdassa
esitettyjen ongelmien vuoksi. Vertailua voidaan Kkuitenkin pitdd suuntaa antavana ja

suuria poikkeamia alihankkijan tuloksiin ei esiintynyt.

TAULUKKO 11. Kationien KVVY vertailun kooste

Analyysi | Kulmakerroin | Korrelaatiokerroin | Analyysimaara

Na* 0.967 0.9982 10
K* 0.9955 0.9982 10
ca’* 0.9638 0.9776 10

Mg** 0.9638 0.9886 10
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KUVIO 8. Natriumin regressiosuora

KVVY (mg/l)
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KUVIO 9. Kaliumin regressiosuora
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KUVIO 10. Kalsiumin regressiosuora
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KUVIO 11. Magnesiumin regressiosuora
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8.5 Laboratorioiden valinen vertailututkimus

Laboratorio osallistui Suomen Ymparistokeskuksen jarjestamiin patevyyskokeisiin
2013 vuoden loppupuolella. Tulokset on esitetty liittessa 6. Naytteiden nimissa
ensimmdinen Kirjain kertoo ndytteen tyypin. A-kirjaimella alkavat néytteet ovat
synteettisid naytteitd, D-kirjaimella alkavat talousvesia ja G-kirjaimella alkavat
raakavesia. Kokeissa kaikkien anionien eli fluoridin, kloridin, nitraatin, ja sulfaatin
mittaukset onnistuivat erinomaisesti. Nitraatin A4N néytteessa suuri ilmoitettu
poikkeama johtuu tulosten nappailyvirheestd, mutta laitteen mittaama tulos vastasi lahes

tasmalleen laboratorioiden keskiarvoa.

Kationien tuloksissa oli enemman hajontaa kuin anionien tuloksissa. Natriumin ja
ammoniumin tulokset vastasivat hyvin SYKE-kokeisiin osallistuneiden laboratorioiden
tulosten keskiarvoja. Ammoniumin tulokset ilmoitettiin indofenolimenetelmélla
mitattuina, mutta tulokset mitattiin vertailun vuoksi my6s ionikromatografilla.
lonikromatografin tulokset vastasivat hyvin SYKE-kokeiden tuloksia. Kaliumin
naytteistd pienimmaén pitoisuuden analyysi epédonnistui hieman ja ionikromatografi
naytti SYKE-tuloksiin verrattuna suurempaa tulosta. Naytteen pitoisuus on lahelld
kaliumin maédritysrajaa ja poikkeama voi johtua 6.1.2 luvussa Kkerrotuista
suodatinpaperiin liittyvista ongelmista. Kaliumin kahden muun naytteen tulokset

vastasivat SYKE-kokeiden tuloksia.

Kalsiumin ja magnesiumin tulokset epdonnistuivat kahden ndytteen osalta merkittavésti.
Synteettisen naytteen tulos oli liian suuri kalsiumin ja magnesiumin osalta. Talousveden
tulos oli lilan pieni kalsiumin ja liian suuri magnesiumin suhteen. Raakavedessa
kalsiumin ja magnesiumin mitatut pitoisuudet olivat hieman liian pienid, mutta ero on
hyvéksyttavissd rajoissa. Tulokset poikkeavat eri suuntiin eri néytteissé, eli virheet

tuskin johtuvat mistaan systemaattisesta virheesta.

Kalsiumin ja magnesiumin analyyseissa havaittiin ndytteen pH:n vaikuttavan joihinkin
tuloksiin erityisesti silloin kun happamasta néytteestd siirryttiin emaksiseen tai
toisinpain. Jos naytteen pH oli paljon happamampi kuin edellisen néytteen, sen kalsium
ja magnesium tulokset olivat liian suuria. Jos néaytteen pH oli paljon emaksisempi kuin

edellisen néytteen, sen kalsium ja magnesium tuloksista tuli lilan pienid. Kun kalsiumia
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ja magnesiumia tutkittiin saantokokeissa luvussa 7.2, kaikissa néaytteissa oli sama pH.
Talloin pH:sta johtuvat vaihtelut eivat valttaméattad ole tulleet esille. Kalsiumin ja
magnesiumin analyysi vaatisi todenndkoisesti ndytteiden happamoimisen. Eluentin pH
pysyy samana kaikilla néytteille ja injektoitava ndytteen maara on pieni. Naytteen pH
saattaa kuitenkin vaikuttaa naytteen kulkeutumiseen néyteputkesta injektiolooppiin.
Kationianalyyseja ei saatu tdysin toimintakykyiseksi ennen injektioneulan vaihtamista ja
neulaan liittyvat ongelmat ovat saattaneet osin peittdd muita kationianalyysiin liittyvia
seikkoja. Jos kalsium ja magnesium analyysit halutaan jatkossa tehd& laboratoriossa,
pitéisi selvittdd naytteen happamoinnin vaikutusta tuloksiin kalsiumin ja magnesiumin

kohdalla. Muiden ionien kohdalla ei havaittu pH:n muuttavan tuloksia merkittavasti.
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9 POHDINTA

Validoinnin tuloksia voidaan pitdd suuntaa antavina, mutta kayttéonottoa haitanneiden
seikkojen vuoksi validointia ei voida pitaa tdydellisend. Laitteen toimintaa seurataan
jatkossa  laboratoriossa  henkilokunnan  toimesta.  Henkil6kunta  koulutettiin
opinnaytetyon tekemisen aikana ja kirjoitettu menetelmédohje avustaa jatkossa laitteen
kaytossd. Anionianalyysit onnistuivat hyvin alusta ldhtien ja on syytd uskoa, ettd
injektioneulaan liittyvat ongelmat eivat ole vaikuttaneet merkittévasti anionilaitteen
toimintaan. Anionimittaukset onnistuivat hyvin sekd opinndytetytssa tehdyissa
vertailuissa ettd laboratorion henkilékunnan patevyyskokeissa.

Injektioneulan  tukkeutuminen  on  todenndkdisesti  vaikuttanut  erityisesti
kationianalyyseihin. Laite saatiin toimintakykyiseksi ammoniumin, natriumin ja
kaliumin suhteen. Kalsiumin ja magnesiumin analyyseissa havaittiin poikkeamia seka
opinndytetyon kokeissa ettd péatevyyskokeiden tuloksissa. Ongelmat paikannettiin
alustavasti naytteiden pH:sta johtuviksi, mutta tarkempi selvitys vaatisi lisatutkimusta.
Jatkossa tulisi selvittdd ndytteiden happamointia laimealla typpihapolla kalsiumin ja

magnesiumin analyyseissa.

Vanhalla ionikromatografilla oli tehty fluoridin, kloridin, nitraatin, sulfaatin ja
ammoniumin analyyseja. Uusi laite saatiin toimintakuntoon kaikkien niiden ionien
kohdalla, joita oli analysoitu vanhalla ionikromatografilla. Lisaksi natriumin ja kaliumin
tulokset olivat alustavasti hyvia ja niita ei teetetd jatkossa alihankkijalla. Kalsiumin ja
magnesiumin analyysien saattaminen toimintakykyisiksi vaatisi vield jossain maéarin
tyotd. Niiden osalta analyysejé teetetdan jatkossa jonkin aikaa sek& alihankkijalla etta

omalla ionikromatografilla vertailun vuoksi.
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LITTEET

LIITE 1. Liuokset ja reagenssit

o1

Nimi Kéyttotarkoitus Erdanumero
0.1 M Na,COg3 Anionieluentti Useita
0.1M NaHCO3 Anionieluentti ”
0.1M HNO3 Kationieluentti ”
0.02M 2,6-pyridiinikarboksyylihappo Kationieluentti ”?
(dipikoliinihappo)
0.5M H,S0O, Suppressoriliuos ”?
Merck. 1.19814.05 NaF 1000 mg/I Anioni standardiliuos HC386532
Merck 1.19897.05 NaCl 1000 mg/I Anioni standardiliuos HC376295
Merck 1.19811.05 NaNO3 1000 mg/I Anioni standardiliuos HC274360
Merck 1.9898.05 KH,PO,4 1000 mg/I Anioni standardiliuos HC274042
Merck 1.19813.05 SO4 1000 mg/I Anioni standardiliuos HC258091
Fluka Multi Cation Standard 1 for IC Kationi standardiliuos | BCBH9514V
(MultiCat)
certified 11/04/2013
Acculon Reference Standard IC-MAN-01- | Anioni kontrolliliuos 212055102
1 (MultiAnioni)
Multi-Component Anion Mix 1
certified 5/23/2012
Multielement lon Chromatography Anion | Anioni kontrolliliuos BCBH1546V
Standard Solution (MultiElement)
Certified 11/01/2012
Acculon Reference Standard Kationi kontrolli liuos 211115027

Multi-Component Cation Mix 1
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LIITE 2. lonikromatografin menetelmaohje

Vesinaytteiden liuenneiden anionien ja kationien maaritykset
ionikromatografilla

1. MENETELMAN SOVELTUVUUS

Menetelmé on tarkoitettu liuenneiden anionien ja kationien maarittamiseen kaikentyyppisista
vesista.

2. PERIAATE

Naytteet suodatetaan ennen analyysia. Suodatus poistaa Kkiintoaineen ja kiintoaineessa
mabhdollisesti kiinni olevat anionit ja kationit. Kaytdssa olevien Metrohmin ionikromatografien
(883 Basic IC plus 2kpl) detektorien toiminta perustuu sahkénjohtavuuteen. Vesinaytteen tai
sen laimennoksen ionit erotetaan toisistaan erotuskolonnin avulla. Anionieluenttina kaytetaan
Na,CO3/NaHCOs-liuosta ja kationieluenttina laimeata typpihappo-dipikoliinihappo-liuosta.

3. LAITTEET JA VALINEET

e vesi-imuri ja membraanisuodattimia (S&S 0.2um, J47mm) veden suodatukseen ja
kaasujen poistoon

kertakayttoruiskuja ja 0.2um ruiskusuodattimia naytteiden suodatukseen

IC-Putket ja korkit

Metrohm 883 Basic IC plus ionikromatografi x2

tietokone MagicNet-ohjelmistoineen ja tulostin

Anionikolonni MetroSep A Supp 5 150/4.0 + Esikolonni Metrosep A Supp 4/5 Guard
Kationikolonni MetroSep C4-150/4.0 + Esikolonni Metrosep C-4 Guard
Autosampler 919 IC autosampler plus

4. REAGENSSIT

Kaikkien reagenssien on oltava analyysipuhdasta laatua ellei toisin mainita.

4.1 Vesi

Kéayta liuosten valmistukseen ja laimennuksiin milli-Q-vetta tai laadultaan vastaavaa vetta.
Suodata eluentteihin kaytettava vesi ja poista siita kaasut vakuumisuodatuksella.

4.2  Anionieluentti ( 3,2 mM Na,COs; + 1,0 mM NaHCO3 )
Huuhtele 2000mI mittapullo suodatetulla milliQ vedella ennen pipetointia.

Laimenna eluentti kaupallisista liuoksista. Pipetoi 64ml 0,1 M natriumkarbonaattiliuosta
(Na,COs3) ja 20ml 0,1M natriumbikarbonaattiliuosta (NaHCO3) 2000mI mittapulloon ja tayta
merkkiin suodatetulla vedelld (4.1)
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4.3 Kationieluentti (1.7 mM HNOz; + 0,7 mM dipikoliinihappo )

Huuhtele 2000ml pullo suodatetulla milliQ vedella ennen pipetointia.

Laimenna eluentti kaupallisista liuoksista. Pipetoi 34ml 0,1 M typpihappoa (HNOs) ja 70ml 0,02
M dipikoliinihappoa (2,6-pyridiinikarboksyylihappo) 2000 ml mittapulloon ja tayta merkkiin
suodatetulla vedella (4.1)

Ala kayta vanhentuneita liuoksia. Dipikoliinihappo voi kiteytytya vanhentuessaan.

44 0.1 M H,SO,

Valmista 0.5 M H,SO, ampullista ja pipetoi sitda 200m| 1000ml:an mittapulloon. Tayta merkkiin
temperoidulla milliQ vedella.

5. STANDARDIT JA KONTROLLIT
5.1 Anionistandardit

Kaupalliset varastoliuokset:

NaF 1000 mg F/I Merck 1.19814.05
NaCl 1000 mg Cl/ Merck 1.19897.05
NaNO; 225.91 mg NO3s-N/I  Merck 1.19811.05 (NO3 1000mg/l = NO3-N 225.91mg/l)

KH,PO,
Na,SO,

326.16 mg PO4-P/I
1000 mg SO/

Merck 1.19898.05
Merck 1.19813.05

(PO, 1000mg/l = PO,-P 326.16mg/l)

Tee temperoiduista varastoliuoksista perusseos A pipetoimalla 500 ml:n mittapulloon:

NaF 2ml (1000)  ->
NaCl 25ml (1000)  ->

NaNO; 25ml(225.91) ->
KH,PO, 15ml(326.16) ->
Na,SO, 25ml (1000)  ->

4 mg F/l
50 mg Cl/
11.296 mg NOs-N/I

9.78 mg PO4-P/|
50 mg SO/l

Tayta merkkiin temperoidulla milli-Q-vedella. Tee kalibrointiliuossarja perusseoksesta

Anionikontrolliliuokset

Multi-component anion standard ( IC-MAN-01-1)
tee kaupallisesta multianioniliuoksesta 20 ja 200-kertaiset laimennokset (A ja B)

litteena

5.2 Kationistandardit

Kaupallinen standardiliuos

olevan taulukon mukaisesti

Fluka Multi Cation Standard 1 for IC.

NH4 400 mg/l
Na 200 mg/l
K 200 mg/l
Mg 200 mg/l
Ca 1000 mgl/l

= 310,6 NH4-N

Tee kalibrointiliuossarja kaupallisesta standardiliuoksesta liitteessa 1 olevan taulukon

mukaisesti.

Kationikontrolliliuokset

AccuStandard Multi-Component Cation Standard



54

tee kaupallisesta multikationiliuoksesta 100- ja 333-kertaiset laimennokset (A ja B) liitteessa 1
olevan taulukon mukaisesti

5.3 Kalibrointialueet

F 0.05 - 2.0mg/l
Cl 1.0 - 25mgll
NO3-N 0.15 - 5.6 mg/l
PO4-P 0.1 - 49mg/
S04 1.0 - 25mgl/l
Na 05 - 6mgl/l
NH4-N 0.7 - 9mgl
K 05 - 6mgl/l
Ca 25 - 30mgll
Mg 05 - 6mgl
6. SUORITUS

6.0 Laitteen esivalmistelut

Ajon alussa tarkista eluenttiliuokset (kationi ja anioni), MilliQ pullo ja 0.1M H,SO, pullot
laitteiden paalta. Lisaa eluenttiliuoksia noin 1-2 ajon valein. Lisaa rikkihappoa ja MilliQ:ta
viimeistaan kun pullossa on puolet jaljella.

Tarkista jateastiat (2 kpl) ja tyhjenna tarvittaessa. Varmista tyhjentamisen jalkeen, etta kaikki
jateletkut ovat jateastiassa.

Tyhjenné autosamplerissa oleva huuhteluastia (Special Beaker 1), huuhtele milliQ vedelld ja
tayta tuoreella MilliQ vedella. Huuhteluastia suojataan parafilmilla. Autosamplerin saa
kaantymaan seuraavasti:

1. Paina Manual nappia ruudun vasemmassa alalaidassa
2. Valitse listasta Auto Sampler

3. Kirjoita "Rack Position” input kohtaan jokin numero esimerkiksi 10 ja paina
Start, jotta laite kaantyy kirjoittamasi numeron paikkaan. Autosampler palaa
automaattisesti oikeaan kohtaan ajon alussa.

6.1 Yleista

Naytteet ladataan autosampler kiekkoon. Ajon alkuun ja loppuun laitetaan MilliQ vesi
ensimmaiseksi ja viimeiseksi naytteeksi seka anioni etté kationipuolella. Erittdin likaisten
naytteiden (esim jatevedet suoraan) jalkeen on syyta ajaa MilliQ vesi naytteena.

Naytesarjassa ajetaan vahintadn yksi MultiCat 100x/MultiAnioni 20x ja jokin laitteen
standardeista esimerkiksi standardi3. Pitkédssa naytesarjassa yksi kontrollinayte
(MultiCat/Anioni) on syyta ajaa my0s sarjan lopussa ja keskella. Nyrkkisdantona 1 kontrolli 10
naytteen valein.

Laite huuhtelee sy6ttoneulan ja naytesilmukan automaattisesti jokaisen naytteen yhteydessa.

6.1.1 Pohjaviivan ajaminen

Ennen ajoa pohjaviivaa ajetaan vahintaan 30 minuuttia tai kunnes pohjaviiva tasaantuu. Valitse
Workspace -> Equilibration pohjaviivan ajoa varten. Valitse metodi sen mukaan haluatko ajaa
vain toisen vai molempien kolonnien pohjaviivaa. Valitse Anionit ja Kationit metodi ajaaksesi
molempien pohjaviivaa. Start HW aloittaa pohjaviivan ajon. Stop HW lopettaa pohjaviivan
ajamisen.
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Tarkista uuden eluentin yhteydessa ettéd pohjaviivan johtokyky pysyy samanlaisena kuin
aikaisemmin. Vie hiiren osoitin pohjaviivan kohdalle (zoomaa tarvittaessa hiiren vasemmalla
nappaimelld) ja tarkista johtokyky ylareunasta. Kationieluentin johtokyky on noin 704 uS/cm.
Anionieluentti 15 uS/cm. Jos johtokyky poikkeaa vanhasta (+ 1% uS/cm), taytyy standardikayra
uusia.

6.2 Naytteiden valmistaminen

Tee naytteistd aiempien tietojen perusteella laimennukset temperoidulla MilliQ vedella. Yrita
osua laimennoksissa kalibrointialueen (5.3) keskivaihelle. Erityisesti Ca, Na, K ja Mg
analyyseissa on tarkeaa, etta analysoitava pitoisuus ei ole liilan pieni mahdollisen
kontaminaation vaikutuksen minimoiseksi.

Putkita naytteet tai niiden laimennokset ruiskulla kayttden huokoskooltaan 0.2um ruisku-
suodatinta. Suodata erityisen likaiset naytteet kahdesti kahdella eri suodattimella (esimerkiksi
lahtevat laimentamattomat jatevedet). Sulje putket korkeilla. Pyri ajamaan naytteet
laimeammasta pitoisuudesta vahvempaan.

Laita nayteputket kiekkoon. Kationit ja anionit voidaan laittaa kiekon eri kohtiin.

6.3 Sekvenssin luominen ja naytteiden valmistelu ajoon
Sekvenssi luodaan Workplace kohdassa Determination Series.
Maalaa hiiren vasemmalla ndppaimella vanha naytesarja ja poista se painamalla delete.
Lisda nayte tuplaklikkaamalla tyhjaa rivia. Valitse metodi (Anioni tai kationi).
Ident kohtaan tulee naytteen nimi.

Sample type kohtaan tulee naytteen tyyppi. Kaikki naytteet ajetaan sample tyyppisind. Uusien
kalibrointisuorien standardit ajetaan sample tyyppisind ja muokataan myéhemmin standard

tyyppisiksi. :

Position kohtaan kirjoitetaan naytteen paikka kiekossa. Naytteiden ei tarvitse olla kiekossa
ajojarjestyksessa. Ajo kulkee ajolistan mukaisessa jarjestyksessa.

Injections =1, Volume = 20, Dilution=1, Sample amount=1

Paina enter ndppéainta kun naytteen tiedot on syotetty oikein. Naytteen tiedot tallentuvat
ajolistaan ja ohjelma siirtyy seuraavalle riville. Voit my6s painaa enterin sijaan “apply”
tallentaaksesi muutokset ja siirtya seuraavalle riville painamalla nuolta oikealle.

Tarkista ajolistan toimivuus painamalla "Test sample table” nappia (vihred oikein merkki).
Korjaa mahdolliset puutteet.

6.3.1 Naytteen lisddminen naytesarjan keskelle

Jos haluat lisata naytteen valmiin naytesarjan keskelle, valitse paikka johon lisdéat naytteen ja
paina hiiren oikealla ndppéimelld insert new line. Ohjelma tekee tyhjan rivin valitun naytteen
ylapuolelle.

Voit myds kopioida olemassa olevan rivin painamalla hiiren oikeaa nappdinté ja copy line.
Lisaa rivi haluamaasi kohtaan paste line komennolla. Muista muuttaa naytteen nimi (ident) ja
position kohta oikeaksi.

Lisda naytteelle oikea metodi ja tiedot. Muista painaa enter tai apply. Lisatty nayte voi olla
missa tahansa kohdassa naytekiekkoa, kunhan position kohta on merkitty oikein.

6.4 Laitteen kaynnistys
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Laitetta ei tarvitse ilmata paivittain jos samalla liuoksella jatketaan tai eluenttia lisataan. limaus
tehdaan vain kun eluentit vaihdetaan kokonaan ja halutaan estaa eluenttien sekoittuminen.

"Stop Hardware when Sample Table is finished” kohdassa tulee olla ruksi. Muista lopettaa
pohjaviivan ajaminen ennen ajon aloittamista (6.1.1)

Aloita ajo painalla Start kun ajolista on valmiina. (Workplace -> Determination Series -> Start)

6.5 Ajon loppuselvitys ja tulosten tulkinta
Ajo loppuu itsestaén ja laite sammuu, kun sekvenssi etenee viimeiseen naytteeseen saakka.

Tarkista telineistd, etté kaikista putkista on otettu naytettd, mutta putkia ei ole pumpattu téysin
tyhjiksi . Heit& pois kaikki muut kuin MilliQ putket ja halutessasi kontrolli ja standardiputket.
Heita pois MilliQ putkien korkit. MilliQ putket voidaan huuhdella ja kayttda uudelleen. Kontrolli ja
standardiputket voidaan huuhdella naytteelld ja kayttaa uudelleen.

Kay ruudulla lapi kaikki ajetut naytteet. Tarkista, ettd pohjaviiva ja piikit nayttavat hyvilta ja etta
ainakin kaikki halutut piikit on nimetty. Tarkista ajettu standardinéyte ja kaupalliset kontrollit.

6.6 Muutokset néaytteisiin

6.6.1 Yleistd Reprocessing komennon kaytosta

Muutoksia naytteisiin tehdaan valitsemalla naytteet Databasen naytelistasta maalaamalla
keltaisiksi ja valitsemalla reprocess komento hiiren oikealla nappaimella. Taméan jalkeen voit
muokata yksittdisen naytteen tietoja valitsemalla sen ja tuplaklikkaamalla sita. Tehtyasi
haluamasi muutokset ne taytyy kasitella reprocessing nappaimella.

Reprocessing -> From Selected Determination -> Paina OK: Ohjelma muokkaa valitun
(keltainen rivi) naytteen metodin kaikkiin reprocess listan naytteisiin.

Reprocessing -> From standards of reprocessing table -> Paina OK: Ohjelma tekee uuden
kalibrointisuoran reprocess listan siséltdmien standardien mukaan. HUOM: Jos standardeja ei
ole, kalibrointisuora haviaa kaikista valituista naytteista!

Jos kalibrointisuora haviaa, voit vield peruuttaa muutokset painamalla cancel. Jos tallensit jo
muutokset OK nappaimella, taytyy naytteisiin ajaa kalibrointisuora uudestaan (6.7.2).

Tallenna muutokset painamalla OK néppainta. Jos OK nappain ei ole aktiivinen, muutoksia ei
ole tallennettu reprocess nappaimen kautta.

6.6.2 Piikkien nimeaminen / Retentioaikojen muuttaminen:

Jos jokin komponentti ei ole nimetty oikein, valitse databasesta keltaiseksi maalaamalla
naytteet joita haluat muokata. Valitse hiiren oikealla ndppéimellé reprocess. Valitse alhaalta
components valilehti ja kohta component table. Valitse komponentti jota haluat muokata.
Voit kirjoittaa uuden retentioajan suoraan taulukkoon kohtaan Time [min] tai siirtéa
kromatogrammissa sinisen viivan uuden retentioajan kohdalle, jonka jalkeen paina Update
Retention Time néppainté.

Muokattuasi retentioajan naytteet taytyy kasitella reprocessing toiminnolla From Selected
Determination -> OK. Jos haluat muuttaa retentioajan myos jatkossa ajettaviin naytteisiin,
valitse Method -> Save as -> Valitse oikea metodi (kationi tai anioni) -> Save -> Yes. Paina OK
tallentaaksesi muutokset reprocess listaan ja siirtydksesi takaisin database osioon.

HUOM: Muokattu retentioaika paivittyy kaikkiin reprocess listan naytteisiin. Valitse listaan vain
ne naytteet, joita haluat muokata.
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6.7 Kalibrointi ja standardisuora

6.7.1 Yleista

Standardeina kaytettavat liuokset l16ytyvat kohdasta 5 ”Standardit ja Kontrollit”. Tee
standardiliuokset liitteen 1 taulukon mukaisesti. Aja standardit normaalisti (6.3) ndytesarjan
mukana heti ensimmaisen kontrollin jalkeen.

Kationeista natrium, kalium, kalsium ja magnesium ovat kontaminaatioherkkig, joten noudata
erityista huolellisuutta standardisuoraa tehdessé. Huuhtele mittapullot MilliQ vedella ennen
kaupallisen standardin pipetointia. Huuhtele nayteputket standardilla ennen tayttoéé. Jos jokin
standardi poikkeaa suorasta, mittaa kyseinen standardi uudestaan.

6.7.2 Kalibrointisuoran laskeminen ja tallennus

Valitse Databasessa uudet standardit ja ne naytteet joihin haluat laskea uuden standardisuoran
maalaamalla keltaiseksi. Valitse reprocess hiiren oikealla nappéimella.

Valitse standardi reprocess listasta ja tuplaklikkaa sitd. Muokkaa kaikkien standardien sample
type kohta sample tyyppisesta standard 1-6 tyyppiseksi. Voit siirtyd seuraavaan naytteeseen
painamalla nuolta oikealle. Kun olet tehnyt kaikki tarvittavat muutokset, paina close.

Valitse vasemmalta alhaalta reprocessing ja From standards of reprocessing table -> OK.
Ohjelma tekee uuden standardisuoran listaan valittujen standardien mukaan.

Valitse reprocess listan viimeinen (alimmainen) nayte ja tarkista uudet kalibrointisuorat
visuaalisesti (Valitse keltaisen ruudun vasemmasta ylakulmasta (Ruudun keskella oikealla
puolella) Calibration Curve). Tarkista korrelaatiokertoimet kaikista komponenteista (0.999...
Mahdollisimman lahella yht&d). Jos kalibrointisuorat ovat ok, valitse reprocessing -> From
selected determination -> OK. Ohjelma muokkaa valitun naytteen standardisuoran kaikkiin
listan naytteisiin. Tarkista, ettéd kontrollinaytteet ovat ok uudella suoralla.

Tallenna uusi kalibrointisuora metodiin valitsemalla Method -> Save as -> Valitse oikea metodi
(kationi tai anioni) -> Save -> Yes. Paina OK tallentaaksesi muutokset reprocess listaan ja
siirtyaksesi takaisin database osioon.

Tulosta uusi kalibrointisuora kohdan 6.8.3 mukaisesti ja arkistoi laitteen vieresséa olevaan
piikkiin.

6.8 Tulostaminen

6.8.1 Etusivun tulostaminen

Valitse databasessa néaytteet jotka haluat tulostaa. Printtaa etusivu valitsemalla File -> Print ->
Determination Overview -> OK. Ohjelma tulostaa etusivun pdf-tiedostoksi ja avaa sen Adobe
Readeriin. Valitse Adobe Readerissa File -> Print ja paina OK.

6.8.2 Naytetietojen tulostaminen

Valitse File -> Print -> Report.

Selection = Selected Determination (Yleensa valittuna automaattisesti)

Report type -> Report template = Oma raporttipohja (yleensa valittuna automaattisesti)

Merkitse ruksi kohtaan printer ja varmista, ettd oikea printteri on valittuna (HP LaserJet 400
M401 PCL 6).
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6.8.3 Kalibrointikayrien tulostaminen

Valitse yksi néayte tai kontrolli tulostettavaksi kasiteltydsi uuden kalibrointisuoran (6.7.2)
Valitse File -> Print -> Report.

Report type -> Report template = Kalibrointi

Muista vaihtaa report template seuraavan tulostuksen yhteydessé omaan raporttipohjaan!

6.9 Raporttien sailytys ja tulosten kirjaaminen
Laita standardiraportit hyllylla olevaan, mybhemmin arkistoitavaan nippuun

Laita tulosten kirjauksen jalkeen Viemlabran anioni- ja kationiraportit hyllylle omiin nippuihinsa.
Jos ajossa oli puhdasvesilabran naytteité, merkitse niiden tulokset koontaraporttiin ja kirjaa
puhdasvesilabran Veka-ohjelmaan.

Omat tulokset: Kirjaa MultiStandardien tulokset Vekan laatukortteihin standardiyhdistelmén
kautta (anionit ja kationit samaan yhdistelmaan). Huomioi naytteiden tuloksissa laimennus-
kertoimet ja kirjaa ne Vekaan. Merkitse mahdolliset rinnakkaistulokset rinnakkaiskorttiin.

6.10 Hakutoiminnot

Ohjelmaan on tehty valmiita hakuja, joiden avulla voidaan rajoittaa databasessa nakyvia
analyyseja. Voit hakea tietokannasta esimerkiksi tietyt kontrollinaytteet. Valitse all
determinations kun haluat ndhda kaikki tehdyt analyysit.

Laitteen laatukortit saat nakyville valitsemalla Filter kohdasta (databasessa naytelistan
ylapuolella) tarkasteltavan kontrollin valmis haku esimerkiksi MultiCat 100x. Valitse hiiren
oikealla nappéaimella Detail Overview -> All Filtered Determinations. Valitse Control Chart.
Valitse oikea template esimerkiksi MultiCat 100x

Uusia hakuja voi tehda valitsemalla Determinations -> Filter -> Special Filter. M&érittele
hakutoiminto sen mukaan mitéa haluat hakea. Kohdassa 6.10.1 on esitetty esimerkkihaun
rakentaminen.

6.10.1 Esimerkkihaku (hakee kaikki Raholan Tulevat naytteet)
Lisaa uusi rivi (Edit -> Insert New Line)
Field = ident (Mita kohtaa naytteista tutkitaan. Ident = naytteen nimi)

Comparative value = *RT* (Mitd arvoa ylla valitusta kohdasta haetaan. *RT* hakee kaikkia
naytteitd, joiden nimesséa on RT jossain kohdassa)

Ruksi kohtaan Use asterisk (*) as wildcard

Paina Apply Filter

6.11 Tulosten tallentaminen muistitikulle

Kiinnité& muistitikku tietokoneeseen. Valitse naytteet jotka haluat siirtédé tikulle. Valitse
Determinations -> Export -> "Tallennus tikulle”. Naytteet tallentuvat muistitikulle, josta voit
l&hettdd ne esimerkiksi Metrohmin yhteyshenkil6lle.

6.12 Tulosten laskeminen ajon aikana

Keskeneraisen naytteen tulokset voidaan laskea ajon aikana, jos tuloksilla on kiire. Valitse
workspacessa hiiren oikealla nappéaimella ajossa olevan kromatogrammin kohdalla properties
-> curve -> Liséé ruksi concentration kohtaan -> OK. Paina Evaluate nappia ja piikkien
tulokset nakyvat niiden ylapuolella.
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7. HUOLTO

Kéayta laitetta huoltaessasi hanskoja. Ala koske laitteen sisaisiin komponentteihin tai
suodattimiin paljain kasin.

Sammuta ohjelma (ruksi oikeassa ylakulmassa) silloin tallgin (1-2 viikon vélein) ja kaynnista
ohjelma uudestaan tyopoydaltd MagicNet kuvakkeesta.

Autosamplerin suodattimen suodatinpaperi tulee vaihtaa 2 viikon vélein tai viimeistédén kun
se tulee likaisen nakdiseksi. Jos hyvin likaisia jatevesia ajetaan ilman laimentamista, saattaa
suodatinpaperi menna kelvottomaksi lyhyemmankin ajan kuluttua.

Ruuvit avataan avaimella. Varo ettet vaurioita suodattimesta lahtevia letkuja. Poista vanha
suodatinpaperi ja huuhtele suodattimen sisalla olevat spiraalipinnat milliQ vedelld. Liota uutta
suodatinpaperia (0,2um 47mm) milliQ vedessa dekantterissa muutama minuutti. Siirra
suodatinpaperi pinseteilla suodattimeen. Varmista ettd suodatinpaperissa on siisti rypytén
spiraali. Ruuvaa suodattimen suojus takaisin ja kirista avaimella.

Laitteiden inline suodattimet (kationi 1kpl, anioni 3kpl) tarkistetaan noin kuukauden vélein.
Suodatinpaperit vaihdetaan viimeistaan kun ne ovat kellertavia. Suodattimien vaihtovali
arvioidaan sen perusteella, kuinka nopeasti suodatin likaantuu, mutta vahintdéan 6 kuukauden
valein. Kuukausittaista tarkistusvalia voidaan pidentaa tarkastuksien perusteella.

K&anna inline suodatin irti k&sin ja avaa irroitettu suodatin jakoavaimilla. Irroita vanha
suodatinpaperi pinseteilla tai neulalla. Huuhdo suodatin milliQ vedelld ja laita uusi paperi
paikalleen. Ruuvaa suodatin kiinni ja kiristé jakoavaimilla. Kiinnitd suodatin takaisin laitteeseen.

Tarkista, ettd suodatin ei vuoda ajamalla huuhteluvetta. Siirrd neula ensin huuhteluastiaan:
Manual -> Valitse Autosampler -> Rack position -> Special Beaker 1 -> Start.

Lift position -> Work Position -> Start.

Aloita huuhtelu: Peristaltic -> Start. Hissin sdadoksissa Work position on alhaalla ja Shift
position on ylhaalla. Huuhtelun nopeutta voit saataa input kohdasta.

Vaihda autosamplerin ja anionilaitteen peristalttisten pumppujen letkut 2-3 kuukauden valein.
Yhté letkua voi kayttaa kaksi kertaa siirtamalla pumpun sisalla olevan letkunpatka toiseen
keltaisten merkkien véliseen kohtaan. Letkussa on 3 keltaista merkkid, eli 2 pumpun sisélle
menevaa letkunpatkaa. Toisen vaihdon yhteydessa koko letku on vaihdettava.

Letkut ovat eri paksuisia, joten varmista etté vaihdat oikeantyyppisen letkun oikeaan kohtaan.
Varmista, etté letku kulkee samaan suuntaan vaihtamisen jalkeen kuin ennen vaihtamista!
Pumppaustehokkuus voi muuttua letkun vaihdon yhteydessa, joten tarkista ettd nayteputkista
menee vaihdon jalkeen edelleen sopiva maara naytetta.

Tyhjenna eluenttipullot 3-6 kuukauden vélein. Lisda pulloon n. 10-20m| HPLC tai IC luokan
asetonia tai etanolia ja ravistele pulloa. Huuhdo pullo milliQ:lla ja anna kuivua ennen uuden
eluentin lisdamista.

Vaihda/pese MilliQ pullo ja eluentin veden suodatuksessa kaytettava pullo joskus. Huuhtele
uusi pullo milliQ vedelld ennen kayttoa.

Eluenttipullojen molekyyliseulat vaihdetaan noin 3 kuukauden vélein.

Vaihda Database vuoden alussa tai viimeistdan kun databasessa on 5000 naytettd. Sulje
aktiivinen database close current database napista. Kéynnista ohjelma uudelleen. Valitse
databasesta File -> Database Manager. Valitse MagIC Net -> Edit -> Rename -> Nime&
vanha tietokanta vuosiluvun perusteella. Valitse Edit -> New -> Nimed uusi tietokanta "MagIC
Net” nimiseksi. Huomioi isot kirjaimet!
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Laitteiden esikolonnit vaihdetaan vuosihuollon yhteydessa kerran vuodessa. Jos vuoden
vaihtovali ei riitd, vaihtovalia voidaan lyhentda 6 kuukauteen.,

Ilmaus on tarpeellinen lahinna vaihdettaessa eluentista toiseen. Avaa venttiili ja kiinnita ruisku
jateletkuun. Laita pumppu péalle: Manual -> Valitse laite -> Flow kohtaan virtauksen arvo ->
Start. Virtaus voi olla iimatessa normaalia suurempi (esim 1-1.5ml), mutta virtaus ei saa olla
normaalia suurempi ruuvin ollessa kiinni. Lopuksi laita virtaus normaaliksi ja laita ruuvi kiinni.
Pysayta pumppu Stop néappaimella.

Ruskeita detektorilta tulevia jateletkuja ei saa lyhentaa. Muita letkuja voi lyhentéa tarvittaessa.

Injektorin neulan voi puhdistaa kastamalla sen putkeen, jossa on sitruunahappoa (noin
lusikallinen per 100-150ml). Varmista, etta et injektoi sitruunahappoa laitteen sisélle. Jos laite on
kayttamatta pitkan aikaa (4 viikkoa tai enemman) kolonnin voi sail6a jaakaappiin korkin kanssa.
Kromatografeilla on kuitenkin parasta, etté laite on jatkuvassa kaytossa.
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8. TULOSTEN TULKINTA

lonikromatografilla tehdyissa ionimaarityksissa on huomattava, etté laite mittaa vain liuenneiden
ionien maarad. Jos naytteessa on paljon kationeja tai anioneja kiintoaineessa, suodattuvat ne
pois ennen mittaamista. Jos IC:lla halutaan mitata ionien kokonaismaaraa likaisista naytteista,
tulisi naytteet esikasitella.

Kokonaistyppea mitataan typenpolttomenetelmalld, joka mittaa kaikkea naytteessa olevaa
typped. Jos IC:l1a mitatut liuennut NH4-N, NO2-N ja NO3-N lasketaan yhteen, yhteissumman
tulisi olla hieman pienempi kuin typenpoltolla mitattu kokonaistyppi, jos naytteessa on paljon
ammoniumia kiinni kiintoaineessa.

Nitrifikaatioprosenttia laskettaessa lahtevan jateveden ammoniumpitoisuus olisi syyta mitata
kaikkea ammoniumia mittaavalla menetelmall&, jos on syyta epdilla ettad naytteessa on
kiintoaineessa kiinni ammoniumia.
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9. ONGELMATILANTEITA

Alla on esitetty erilaisia ongelmatilanteita ja niiden mahdollisia selityksia.

Kontrollit ja standardit pienenevét

Autosamplerin suodatinpaperi saattaa olla likaantunut ja se taytyy vaihtaa.
Hyvin likaisista jatevesista saattaa jaada ioneja pidattavia aineita
suodatinpaperiin.

Eluentin koostumus on saattanut muuttua. Tarkista johtokyky vertaamalla
vanhaan ja uusi tarvittaessa kalibrointisuora

Esikolonni on saattanut likaantua ja taytyy vaihtaa.

Jalkimmaisen laitteen kontrollit heittavat ja ensimmaisen laitteen pysyvat normaaleina

Jalkimmaisena olevan laitteen néytelooppi ei valttamatta tayty kokonaan.

Kokeile laitteen ohjelmassa olevan injektionopeuden korottamista tai
peristalttisen pumpun letkujen vaihtamista.

Jos Nayteputkiin jaa injektion jalkeen enemman naytetta kuin yleensa, voi
se nakya tuloksissa viimeisena olevan laitteen tuloksien pienenemisena.
Saattaa johtua letkujen litistymisesta, jolloin ndyte ei paase virtaamaan
riittdvan nopeasti

Injektioneulasta peristalttiseen pumppuun kulkee paljon ilmaa

o Kiristé injektioneulan ja pumpun letkujen liitokset ja tarkista
pumppaamalla vetta, ettd ilmaa ei enda tule paljon. Varo etté et
riko liitoksia kiristaessa.

o llmakuplia saattaa tulla normaalissakin tilanteessa jonkin verran,
mutta niiden tulisi tulisi jAdda peristalttiseen pumppuun tai
suodattimeen.

o Tarkista, ettd ruskeiden letkujen paat ovat tasaisia. Katkaise
tarvittaessa pala letkusta leikkurilla. Leikkurissa on pieni reika
letkun siistia leikkaamista varten.

o Tarkista, etta neulan reika ei ole tukossa. Muovikorkeista saattaa
jaadda palanen muovia kiinni neulaan.
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Anionit F Cl NO3-N PO4-P S04
Perusliuos 1x 4 50 11,296 9,784 50
Laimennus
perusliuoksesta

Standardi6 2X 50/100 2 25 5,648 4,892 25
Standardi5 3,33x 30/100 1,2 15 3,389 2,936 15
Standardi4 5x 20/100 0,8 10 2,259 1,957 10
Standardi3 8x 25/200 0,5 6,25 1,412 1,223 6,25
Standardi2 20x 10/200 0,2 2,5 0,5648 0,489 2,5
Standardil 80x 2.5/200 0,05 0,625 0,141 0,122 0,625
MultiAnioni 1x 20 30 22,6 48,9 150
MultiAnioni 20x 5/100 1,0 15 1,13 2,45 7,5
20x
MultiAnioni | 200x 5(20x)/50 0,1 0,15 0,113 0,245 0,75
200x
Kationit Laimennus Na NH4-N K Ca Mg

kaupallisesta

standardista
Tyoéliuos 10x 10/100 20 31,06 20 100 20

Laimennus

ty6liuoksesta
Standardi6 3,33x | 30/100 6 9,318 6 30 6
Standardi5 5x 20/100 4 6,212 4 20 4
Standardi4 6,66x | 15/100 3 4,659 3 15 3
Standardi3 10x 10/100 2 3,106 2 10 2
Standardi2 20x 5/100 1 1,553 1 5 1
Standardil 40x 2.5/100 tai 0,5 0,7765 0,5 2,5 0,5

5/200
MultiCat 1x 200 310,6 200 1000 200
MultiCat 10x 10/100 20 31,06 20 100 20
Tyoliuos
MultiCat 100x 10(10x)/100 2,0 3,1 2 10 2
100x
MultiCat 333x 3(10x)/100 0,6 0,93 0,6 3 0,6
333x




LIITE 3. Kalibrointisuorat ja mittaukset
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Teoreettinen

Teoreettinen

o Pinta-ala o Pinta-ala
F pitoisuus ) Cl pitoisuus )
(US/cm)*min (US/cm)*min
(mg/l) (mg/l)
Std 1 0,05 0,016 Std 1 0,625 0,108
Std 2 0,20 0,052 Std 2 2,50 0,420
Std 3 0,50 0,124 Std 3 6,25 1,085
Std 4 0,80 0,20 Std 4 10,0 1,875
Std 5 1,20 0,308 Std 5 15,0 2,983
Std 6 2,00 0,528 Std 6 25,0 5,402
Teoreettinen _ Teoreettinen _
o Pinta-ala o Pinta-ala
NO3-N pitoisuus ) SO4 pitoisuus )
(uS/cm)*min (US/cm)*min
(mg/l) (mg/l)
Std 1 0,05 0,016 Std 1 0,625 0,108
Std 2 0,20 0,052 Std 2 2,50 0,420
Std 3 0,50 0,124 Std 3 6,25 1,085
Std 4 0,80 0,20 Std 4 10,0 1,875
Std 5 1,20 0,308 Std 5 15,0 2,983
Std 6 2,00 0,528 Std 6 25,0 5,402
Teoreettinen _ Teoreettinen _
o Pinta-ala o Pinta-ala
Na pitoisuus ) NH4-N pitoisuus )
(uS/cm)*min (uS/ecm)*min
(mg/l) mg/l
Std 1 0,50 0,534 Std 1 0,777 1,172
Std 2 1,00 1,019 Std 2 1,553 2,338
Std 3 2,00 2,029 Std 3 3,106 4,729
Std 4 3,00 3,007 Std 4 4,659 7,075
Std 5 4,00 3,996 Std 5 6,212 9,463
Std 6 6,00 5,965 Std 6 9,318 14,188
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K Teoreettinen Pinta-ala ca Teoreettinen Pinta-ala
pitoisuus (uS/cm)*min pitoisuus (US/cm)*min
Std 1 0,50 0,301 Std 1 2,50 2,214
Std 2 1,00 0,547 Std 2 5,00 4,757
Std 3 2,00 1,084 Std 3 10,0 9,346
Std 4 3,00 1,618 Std 4 15,0 13,596
Std 5 4,00 2,160 Std 5 20,0 17,975
Std 6 6,00 3,258 Std 6 30,0 26,933
Mg Tec?refattinen Pinta-ala |
pitoisuus (uS/cm)*min
Std 1 0,50 0,912
Std 2 1,00 1,918
Std 3 2,00 3,790
Std 4 3,00 5,522
Std 5 4,00 7,320
Std 6 6,00 10,962
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LITE 4. Ammoniumin indofenolimenetelma

Liitessa on lyhennelmé Tampereen Veden (2013) ammoniumin
indofenolimenetelméstd. Menetelma perustuu SFS (1976) veden ammoniumtypen

maaritys standardiin.

Nollanaytteeksi pipetoidaan 25ml termostoitua (20 °C) milliQ vettd vahintdan kahteen
mittapulloon. Néyte laimennetaan pitoisuusalueelle 0,05 — 0,40 mg/l. Naytelaimennosta
pipetoidaan 25ml kahteen mittapulloon. Néytteet varjataan lisdéaméalla 1ml
natriumsitraattiliuosta, Iml fenolinitroprussidiliuosta  ja Iml alkalista
hypokloriittiliuosta. Naytettd sekoitetaan jokaisen lisdyksen jalkeen ja jatetaan
varjaytymaan pimedan 2-24  tunniksi, jonka jélkeen naytteet mitataan

spektrofotometrilla.
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LIITE 5. Kovuuden maaritys EDTA-titrauksella

Liittessd on lyhennelmd& Tampereen Veden (2002) veden kokonaiskovuuden maaritys
menetelmastd. Naytettd mitataan 50ml mittalasilla dekantterilasiin ja lisataan
ammoniumkloridia ja meteeniamiinia siséltava kaupallinen indikaattoritabletti.
Dekantteriin lisatddn 1ml 25% ammoniakkiliuosta ja titrataan EDTA-liuoksella
sekoittaen naytettd magneettisekoittajalla. Titrausta jatketaan kunnes vari muuttuu

punavioletista kirkkaan vihreaksi.
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LIITE 6. SYKE tulokset

Analyte Unit | Sample z-Graphics Z-value Outl| Assig- | 2° | Lab's | Md. | Mean | SD |SD%|Pas-| Outl.| Mis- | Num
3940488 test| ned |Targ| result sed | fai- | sing| of

‘OK value |SD% led labs

Ca man | AR o0 B8 01080 18 |00 (05082 1T 0 0 o
L ) Q| — A1 H|18 |10 143 |1816 |1814 |09391 |52 ||28 |1 |0 |28

mgl | G3K —_— 0909 yes|242 10 |231 (2421 [2425 (1302 (54 |30 [0 |0 |30

C mal | ATS 0000 yes|BoB |10 608 B3 [6026 02106 |38 | 2 0 |o7
mgl | D28 o 0194 yes|516 |10 |511  |5131 |5138 |0,1802 |35 ||30 [4 |0 |34

mgl | G398 0099 yes|807 |10 |811 |805 (8083 |03151 |39 ||3¢ |1 |0 |36

F mal | AIF . 0174 yes| 1156 |10 |1.14  |1.152 1,164 |0.05685]49 ||31 |0 |0 |a1
mgl | D2F — 0727 yes |01 |15 [0104 (01045 [0,1048 |0,00905(85 |19 |6 |2 |27

Fe T | Alre n 0160 yes 150 10 1060 1248 [TAT |55 |42 |31 [0 [0 [a1
ugl | G3Fe - 0875 yes|800 |10 (835 (807 (7973 |3654 |45 |30 |1 [0 |31

K mal | AIK T yes 0628 10 0.7 0603 |08 004 18 21 3 |1 &
mgl | DK - 0282 yes|142 |10 144 1415 [1415 |004884(35 |20 |2 |0 |2

mgl | G3K —_— 0988 yes|324 10 (308 (3225 (3232 (04581 |49 |22 |1 |0 |2

g man | AR —ry RN Ny | VRN VI V1Y VK5 K ST A VI
mgl | DX 10730 H [151 |10 [232 [1502 (1498 (0090346 |21 |5 [1 |27

mgl | GK — 4169 yes|924 |10 (870 (9282 (9239 03841 |42 |26 |2 |0 |28

T gl | Alre — S S Y £ S % I V2 BB BT T N [ R
ugl | G3Fe - 0838 yes|167 |10 174 167  [1868 |8973 |54 |25 [0 [0 |26

N-NA2 mal | DN p— 1250 yes 0064 |10 0,060 00627 |0.06571 [0005088 1129 12 |1 |2
mgl | G3N 3070 yes|071 |10 0819 (0708 [07115 |0,04474|63 |30 3 [0 (33

o3 mal | AN D081 yes 123 10 120 L2 1212 00851 o |2 2 [0 |3
mgl | AdN 990000 H |116 |10 |5858 |116 |1,157 |0,0523 |45 ||30 |4 |0 |34

mgl | DN u 02357 yes|093 |10 0941 10923 (09268 00468 |5 |29 |4 [0 (33

mgl | G3N (1797 yes|023 |15 |0261 |0229 |02261 |0.03057|135|27 |5 |0 |32

Na mal | AIK - 0200 yes|1a8 |10 140 |1.306 |1.972 |0.00641165 1123 |2 |0 |&
mgl | DK - 0660 yes|576 |10 |595 |58  |5759 (03425 |59 |]2t |1 |0 |2

mgl | G3K - 0407 yes|295 |10 (289 (298 (2946 |1341 |48 |21 |2 [0 |2

500 mal | ATS = 0500 yes 151 10 155 |52 1525 05408 142 |00 1|0 [a1
mgl | D28 . 0163 yes 246 |10 248 (246 [2464 (09833 [4 |29 |1 |0 |30

mgl | 638 - 0324 yes|185 |10 [188 1844 [1844 (0594 (32 |29 |1 |0 |30




